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ABOUT THIS RELEASE 
This document describes the enhancements for ERDAS IMAGINE, including IMAGINE Photogrammetry (formerly 
LPS Core) and ERDAS ER Mapper. Although the information in this document is current as of the product release, 
see the Hexagon Geospatial Support website for the most current version.  

This release includes both enhancements and fixes. For information on fixes that were made to ERDAS IMAGINE 
for this release, see the Issues Resolved section. 

This document is only an overview and does not provide all of the details about the product's capabilities. See the 
online help and other documents provided with ERDAS IMAGINE for more information. 

ERDAS IMAGINE PRODUCT TIERS 
ERDAS IMAGINE

®
 performs advanced remote sensing analysis and spatial modeling to create new information. In 

addition, with ERDAS IMAGINE, you can visualize your results in 2D, 3D, movies, and on cartographic-quality map 
compositions. The core of the ERDAS IMAGINE product suite is engineered to scale with your geospatial data 
production needs. Optional modules (add-ons) providing specialized functionalities are also available to enhance 
your productivity and capabilities. 

IMAGINE Essentials
®
 is the entry-level image processing product for map creation and simple feature collection 

tools. IMAGINE Essentials enables serial batch processing. 

IMAGINE Advantage
®
 enables advanced spectral processing, image registration, mosaicking and image analysis, 

and change detection capabilities. IMAGINE Advantage enables parallel batch processing for accelerated output. 

IMAGINE Professional
®
 includes a production toolset for advanced spectral, hyperspectral, and radar processing, 

and spatial modeling. Includes ERDAS ER Mapper. 

NEW PLATFORMS 

WINDOWS 10 
ERDAS IMAGINE 2016 has been tested and declared Supported on the Windows 10 Pro (64-bit) operating 
system. 

VIRTUALIZATION 
ERDAS IMAGINE has been tested against several such technologies: Microsoft

®
 Application Virtualization 

5.0.1104.0 and Citrix XenApp
®
 6.5 and 7.6. While ERDAS IMAGINE 2016 is supported with Microsoft Application 

Virtualization, it is considered Viable with XenApp Session Virtualization. 

JAVA 
In light of many concerns regarding the security implications of installing a Java Runtime, Java (v 1.7.0.80) is now 
an optional (and turned off by default) feature in the ERDAS IMAGINE install wizard. Java is only required for the 
workflow of publishing Spatial Models as Web Processing Services (WPS) to an APOLLO Professional server. 
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NEW TECHNOLOGY 

SPATIAL MODELER 
One of the key development areas targeted for this release of ERDAS IMAGINE was to continue the development 
of Spatial Modeler in order to provide ever increasing levels of flexibility for users to implement new geoprocessing 
algorithms, to customize ERDAS IMAGINE, and to publish new products via Hexagon Geospatial’s new cloud-
based Smart M.Apps. To this end, over a hundred new or improved operators have been added to Spatial 
Modeler, along with other improvements aimed at producing a more flexible and fully featured geoprocessing 
capability that covers not only raster-based functionality, but also point cloud and vector-feature functionality. 

FORWARD AND BACKWARD COMPATIBILITY 
The standard approach with new versions of a software application is for files to be backward compatible (i.e. the 
new version of software works with files produced by older versions). Hexagon Geospatial also attempts to make 
our software products forward compatible if possible (i.e. files produced in new versions of software work in old 
versions of software). But forward compatibility can never be guaranteed because new software has new 
capabilities. If you create a model that uses an operator that is not present in older versions of the software - that 
model will not work in the older software.  

With the release of ERDAS IMAGINE 2016 there is so much new functionality in Spatial Modeler (e.g. over a 
hundred new operators) that models created in ERDAS IMAGINE 2016 cannot work in prior versions. But old 
models will work in ERDAS IMAGINE 2016 (until you save any edits in 2016 at which point they become v2016 
files). 

NEW OPERATORS FOR SPATIAL MODELER  
 

Hexagon Geospatial has added over a hundred new operators to Spatial Modeler. This section is an alphabetical 

listing of the new (or modified) operators with a brief description of their capabilities. Please refer to the ERDAS 

IMAGINE 2016 Help for full details of each operator, as well as to the Hexagon Geospatial Community / Spatial 

Recipes page for examples of Spatial Models which use many of these capabilities. 

ADD ATTRIBUTE BY ORDER 

 

Adds a new attribute field name to the input Features object and populates the new attribute with values from an 
input table. 

ADJUST STATS 
If a raster is being stretched through a lookup table (LUT) this operator provides a means to efficiently approximate 
new statistics for the output raster without having to actually calculate statistics.  

 

http://community.hexagongeospatial.com/t5/Spatial-Recipes/tkb-p/KS_SpatialModeler_AnalyticalRecipes
http://community.hexagongeospatial.com/t5/Spatial-Recipes/tkb-p/KS_SpatialModeler_AnalyticalRecipes
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The Adjust Stats operator adjusts the input RasterStats using the input lookup table. The output StatsOut contains 
the RasterStats after the adjustment. If StatsIn contains the statistics for a Raster, StatsOut will contain 
approximate statistics for that Raster as mapped through the lookup table using the Direct Lookup operator. 
Adjusting statistics in this manner is likely more efficient than recomputing statistics with the Statistics operator on 
the output Raster. 

 

ANOMALY DETECTION 

 

Anomaly Detection is the process of searching an input image to identify pixels that have spectral signatures that 
deviate markedly from most other pixel spectra in the image (the background spectra). This operator applies 
Anomaly Detection to RasterIn, which must be multispectral (that is, its band count is larger than 1), and generates 
a single-band continuous raster where pixels with higher values are considered more anomalous. 

AOI INPUT 
Enables an AOI (area of interest) to be input to a Spatial Model. This would most frequently be used in conjunction 
with the Apply AOI operator to mask a raster stream. 

 

APM PARAMETERS 
This operator sets up the parameters needed for Automatic Point Matching (APM). The output from this operator is 
used as one of the inputs to the Automatic Point Match operator. 

APPLY AOI 
The Apply AOI operator applies an AOI, or area of interest, to the input Raster. This either includes or excludes the 
pixels within the AOI, determined by whether the Invert port is set to true or false. Inputs for this operator include a 
Raster through RasterIn, an AOI through AOI, and a Boolean through Invert. The output is the modified Raster 
through RasterOut. 

APPLY INDEX 

 

Apply an index (band ratio, or image algebra, operation) to the pixels of a raster. This operator provides easy 
access to all the standard indices built into ERDAS IMAGINE which are applicable to a given sensor type (based 
on the wavelengths covered by that sensor). 
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APPLY MASK 

 

The Apply Mask operator applies a mask Mask to the input raster RasterIn. Based on the pixel values of Mask, 
and the boolean Invert, output pixels of RasterOut are either the same as RasterIn, or are set to NoData. 

ARE DICTIONARIES EQUAL 

 

Use the Are Dictionaries Equal operator to compare two Dictionary objects' elements. If all of the elements have 
the same names and values, true is set on the AreEqual port. If they do not, then false is set on the port. 

Dictionaries are a new concept introduced with this version of ERDAS IMAGINE to store and use Name / Value 
pairs. For example, image metadata is often stored as such Name / Value pairs, such as  SPACECRAFT_ID = 
LANDSAT_8 and SENSOR_ID = OLI_TIRS. Dictionaries can therefore be used to store, use and modify such 
pairings. 

ARE EQUAL 

 
Use the Are Equal operator to determine if two inputs are equivalent, that is, that they share the same value but do 
not necessarily have the same datatype. The inputs for this operator can be of any datatype except Raster, Vector, 
Features, Point Cloud, Attribute Table, or Metadata. 

ASSOCIATE ELEVATION 

 

The Associate Elevation operator allows you to specify the elevation source for a CoordinateOperation that 
considers elevation. The output, GeoreferencingOut, is a CoordinateOperation object that includes either a 
constant elevation or a reference to an elevation (DEM) filename. Associating a DEM with a CoordinateOperation 
that has a 3D component may improve the accuracy of orthorectification when that CoordinateOperation is used 
with operators such as Warp and Orthorectify. 

ATTACH METADATA 
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Attaches Metadata to RasterIn. Any existing metadata is replaced. If no Metadata is supplied, RasterOut will have 
no attached metadata. 

Metadata is the details of the data of a Raster. In ERDAS IMAGINE, general metadata can be viewed using the 
Metadata tool. The metadata in IMAGINE is stored as Metadata data type, which is a specialized Dictionary which 
handles only metadata. 

Spatial Modeler handles all the non-general metadata. When you want to access the general metadata of a Raster 
in Spatial Modeler, use the Raster Information operator.  

ATTACH VERTICAL CRS 

 

Attaches a Vertical coordinate reference system (CRS) to the input SpatialDataIn. Currently this can be applied to 
raster or features data types. 

VerticalCRS may be a single CoordinateReferenceSystemID, in which case it is attached to the default elevation 
band (in the case of raster) or the primary geometry field type (in the case of features). It may also be a List 
containing multiple CoordinateReferenceSystemIDs, in which case the number of elements in the list must be the 
same as the number of bands, or geometry field types, of SpatialDataIn. 

AUTOMATIC POINT MATCH 

 

Generates tie points from a list of images that have associated RPC model information. Commonly used to 
generate tie points to be used in the Data Triangulation operator. 

BOOL INPUT 
Creates a Bool which can be set to True or False.  

BOUNDARY INPUT 
Create a boundary consisting of an upper-left x,y, lower-right x,y and a coordinate reference system (CRS). Data 
passing downstream of this operator will be constrained to the spatial extent and CRS specified (unless acted 
upon by another operator which manipulates extent and CRS). 

CHANGE FROM COHERENCE 
This operator detects changes between the images in a SAR image pair by identifying anomalous pixels in a 
coherence image derived from the pair. 

file:///H:/Hexagon/ERDAS%20IMAGINE%202016/help/html/index.htm%23SML_IMAGINE_RasterInformation.htm
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CHIP TO NITF 

 

Chips and cores input imagery and graphic overlays into a NITF file. 

CLASS NAME TO PIXEL VALUES 

 

Given a known Class Name, this operator returns the pixel value (DN) of that class name in a given thematic 
raster image. 

COHERENCE FROM SAR IMAGE PAIR 
This operator generates a coherence image from a co-registered SAR image pair (see Change from Coherence 
above) 

COLOR RAMP INPUT 

 

Reads a color ramp from a LUT file and outputs a Color Table. 

COMPUTE AFFINE APPROXIMATION 
This operator computes an affine approximation between ground space and image space. 
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The affine transformation will be based on all the vertices of the features or four corners of the boundary specified 
in TransformArea. The TransformArea can be either in ground space or in image space. if a point is in image 
space, then a ground space point will be computed using the specified Georeferencing; if a point is in ground 
space, then an image space point will be computed using the specified Georeferencing. With all the vertices 
having both image space points and their corresponding ground space points, a 6 parameter affine approximation 
will be calculated for converting ground space coordinates to image space coordinates. 

COMPUTE TRANSFORM 

 

This operator takes control points and their measurements in an image and creates a transform from the image 
coordinate system to the control point coordinate system. 

CONVERT 
Converts the data on the Input port to the specified DataType.  

 

CONVERT RASTER TYPE 

 

Converts a raster to the specified pixel type. The pixel type of RasterOut will be set to PixelType. Any pixel 

values of the input raster that fall outside of the valid range of the specified output PixelType will be clipped to the 

valid range. 

CONVERT TO FEATURES 

 

The modern equivalent of “Raster to Vector”. Takes as Input a thematic raster and converts contiguous groupings 
of classes (pixels with the same thematic value) to create geometry based Features. The isClumped flag 
determines if the operator needs to clump the Input thematic raster prior to converting to Features. Attribute fields 

are copied from the input raster to the output features. 
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CONVERT TO RASTER 

 

The modern equivalent of “Vector to Raster”. Reads input features or an AOI, converts to raster, and returns raster 
data. If the input is features, an attribute of the features can be selected to be used for the output raster value. 

COORDINATE TRANSFORMATION 

 

Transforms the specified geometry field(s) of the input features to the specified target coordinate system. It 
supports 3D coordinate transformation. 

COORDINATEREFERENCESYSTEMID INPUT 

 

Creates a CoordinateReferenceSystemID. Double-click the operator to open its configuration dialog.  

COPY FILE TO DIRECTORY 

 

The Copy File To Directory operator copies the input file and all its subfolders to the specified Directory. All of 

the input File's attributes are copied and remain the same on the copied version of the file. However, associated 
auxiliary files are not copied. If the specified Directory on the OuputDirectory port does not exist, the operator will 
create the Directory. 

COREGISTER SAR IMAGE PAIR 
This operator co-registers an interferometric image pair. See Change from Coherence above. 

CREATE COLOR RAMP 
This operator generates a color ramp with NumLevels colors for a particular raster dataset. The output is a color 

Table whose size is determined by NumBins or by a Histogram (or RasterStats). 
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The operator also supports the use of absolute data start and end values to be associated with the start and end 
colors, thereby providing a means to create color ramped raster data which is standardised across different 
datasets. 

CREATE GEOSPATIAL PDF 

 
Creates a Geospatial PDF file from input imagery and vector overlays. The resulting Geospatial PDF will retain the 
inputs as separate layers in the PDF file, enabling control over whether they are displayed or hidden when 
displayed in a PDF Reader. 

CREATE MAP COMPOSITION 

 

Creates a map composition for multiple raster inputs and graphic overlay files. Optionally a Map Template can be 
used to control the size and layout of the map composition that is created. 

CREATE RSETS 

 

The Create RSETs operator computes NITF RSETs, or NITF-style reduced resolution set, for any image type. The 

input for this operator is an image type through FilenameIn. The output are RSETs, R1, R2, R3, and so forth, 

depending on the size of the input.  

CREATE TEMP FILENAME 
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The Create Temp Filename operator creates a name for a temporary file in the containing Model's temporary 

directory. The output Filename can be used as a File throughout the Model. Once the Model is finished running, or 

is destroyed, the temporary file is automatically deleted. 

DATA INPUT 

 

Use the Data Input operator to take in any JSON (JavaScript Object Notation) text file of a single element and 

output that element for use in the Spatial Model Editor. This operator can take in one element of a persistable data 
type at a time. 

DATA OUTPUT 

 

Use the Data Output operator to save data from the Spatial Modeler to a text file in JSON (JavaScript Object 

Notation) format. The FilenameIn port takes in the location and filename to use for the output. By default, this 
operator saves the output as a .json file. 

DATA TRIANGULATION 

 

Performs triangulation of RPC models using a polynomial-based refinement method based on the input control 
points. The output includes the adjusted model parameters, model transforms and triangulated points whose 
ground coordinates are defined in the Geographic (Lat/Lon) coordinate system using WGS 84 as the horizontal 
and vertical datum, degrees as the horizontal units, and meters as the vertical units. This operator supports only 
those RPC models with the coordinate reference system defined in Geographic (Lat/Lon) using WGS 84 as the 
horizontal and vertical datum, degrees as the horizontal units, and meters as the vertical units. 

DATETIME INPUT 

 

Creates a DateTime. Double-click the operator to open its configuration dialog. The Enter Date, Time and Time 
Zone dialog opens. 
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DEFINE PROCESSING AREA 

 

Defines the Processing Area for raster processing, including the characteristics of the area such as extent, 
projected coordinate system, pixel size, etc. 

Double-click the operator to bring up the Define Processing Area dialog to set options. Input port visibility and 
requirements are highly interdependent, so it is much easier to use the dialog to set options rather than setting 
options from the Properties pane. Clicking OK from the dialog will set values on input ports, and show or hide ports 

depending on the options selected. Input ports may be connected afterward if necessary.  

This operator replaces much of the functionality of the Processing Properties dialog, which has been deprecated. 
Any model created in earlier version of Spatial Modeler or Legacy Spatial Modeler that has Processing Properties 
defined will use the options set there until they are cleared. Options set in the Define Processing Area operator 
will not be used until the existing options defined in Processing Properties are deactivated by clicking the Clear 
button in the Processing Properties dialog. 

Replacing the global Processing Properties dialog with an operator provides far greater flexibility in controlling the 
behaviour of a Spatial Model. A simple example would be a model with three input rasters where you wish to 
initially process the Union extent of two of the inputs and then use the Intersection of the results and the third input 
for the remainder of the model. This would have been impossible previously. 

DELETE DIRECTORY 

 

The Delete Directory operator deletes the input Directory and all of its contents. 

DENSITY INTERPOLATION 
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Kernel density estimation is used to identify the probability of density using seemingly random locations. 
Specifically, this operator can be used to extract areas where the concentration of locations/events/incidents are 
particularly high and thereby delineate clusters or hot areas. Input into this operator could include, for example, 
Epidemiological events (pandemic locations), Law Enforcement events (crime locations), Utility events (outage 
locations), or Transportation events (accident locations). The output of this operator is a single layer raster 
containing a statistical surface that represents density values. This output is a visually attractive surface and helps 
to invoke further investigation and exploration of the reasons behind why incidents are concentrated in some 
areas. The resulting values of the density map are expressed as units of density. 

DICTIONARY 

 

The Dictionary operator creates a Dictionary using the inputted names and data. The NameN port takes in a 

String, and the ValueN port takes in data of any kind. 

DICTIONARY ITEM 

 

The Dictionary Item operator references the item or items with the specified name or names from a Dictionary. 

The Dictionary port takes in a Dictionary item, and the Name1 port takes in a String, which is used to search for 
the item with the matching name in the Dictionary. 

DIRECTORY INPUT 

 

Creates an instance of the Directory data type. This does not create a directory in a file system, but rather it 
creates an object containing a directory path which can be passed to another operator which expects a Directory 

as input, such as Multi Filename Input. 

DOUBLE INPUT 
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Creates a Double (64-bit floating point number). 

DRA STRETCH 

 

One of several new operators added in order to support Softcopy Image Processing Standard (SIPS) image 

processing chains. Use the DRA Stretch operator to apply a Dynamic Range Adjustment (DRA) stretch to the 

input Raster. A DRA is a linear remapping of the pixel data of a Raster that results in a change in the image's 
contrast and brightness. The DRA Stretch operator uses a scale (the input from the Multiplier port) and an offset 
(the input from the Subtractor port) to remap the pixel data. This adjustment is done for each band of the Raster 

independently of each other. 

ELEVATION TRANSFORM 

 

This operator transforms the height (z) values of a raster elevation band from one vertical coordinate system to 
another. 

ENUMERATE CLASS NAMES 

 

Gets the non-empty thematic class names from a thematic raster image. This operator looks for an attribute field 

with the name specified on the ClassColumnName port to get the names. If the named attribute field does not 

exist, the operator returns class names in the format Class_<N> for each histogram value. Any classes / pixel 
values with zeroes in the histogram are omitted.  

ENUMERATE SIGNATURES 

 

Generates a list of the names of the signatures stored in a SignatureList that is generated by a Signature Input 
operator. 
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EXAMINE CRS ID 

 

This operator exposes a useful subset of the parameters that define the coordinate reference system that is 
identified by the CoordinateReferenceSystemID on the CRS input port. A few of the most commonly accessed 
parameters are exposed as directly-accessible, string-valued output ports. The full set of CRS defining parameters 
are placed into a Dictionary-valued output port (CRSParameters). 

EXPAND ENV VARS 

 

The Expand Env Vars (Expand Environment Variables) operator returns the full string, or list of strings, of the 

designated environment variable. The variable can be from the System, User, or ERDAS IMAGINE environments. 

FEATURES DATABASE OUTPUT 

 

Writes features data to a database. OutputTableName is the name of the new Feature in the database. 

FILE INPUT 

 

Creates an instance of the File data type, which holds a filename. Double-click the operator to open a File Input 
File Selector 

FROM STRING 

 

The From String operator converts the input String to a specified data type, designated by the DataType port. For 

exmple, this can be very useful if reading a string value from a Dictionary and needing to convert that to an Integer, 
or other numeric value, to use elsewhere in a model. 
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GENERATE CONTOURS 

 

Generates a set of contour features from a digital elevation model raster. 
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GENERATE EPIPOLAR PAIR 

 

This operator generates an epipolar resampled image pair from a stereo pair of images. The operation will fail if 
the computation exceeds either YParallaxThreshold or RPCResidualThreshold. 
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GENERATE SHADING 

 

Generate Shading operator provides the capability to create shaded relief given a specified date/time and an input 
digital elevation model raster. Illumination can be from the Sun or Moon. It also has the option to include shadows 
in the processing. 

Unlike the simple Relief operator, the output raster from Generate Shading is in units of irradiance (Watts per 
square meter) at the specified point in time for the given time zone. 

 



 

New Technology 

 

May 26, 2016 27 

 

GENERATE SURFACE 

 

This operator extracts terrain from a stereo image pair. The operation will raise an error if no points can be 
generated for the output given the input parameters. 

GET ACTUAL BITS PER PIXEL 

 

Use the Get Actual Bits Per Pixel operator to determine the ABPP (Actual Bits Per Pixel) required to hold the 

range of data of the pixels in the Raster. ABPP is distinct from the Number of Bits Per Pixel (NBPP), the bits used 

to store the data. 

For example, most commercial satellite imagery is delivered in a 16-bit integer image data type (NBPP = 16), but 
the actual dynamic range of the sensor is constrained to a range of 0 to 2047, an 11-bit range (ABPP = 11). This 
distinction can be very useful when determining how to stretch data as part of a model. 

GET BASENAME 

 

Use the Get Basename operator to get the basename, or root filename. This operator can be used with just the 

filename or with the entire path. You can choose to include or exclude the extension of the file with the 
RemoveExtension port. 

As part of a model you can use this operator to, for example, identify other ancillary metadata files which share the 
root filename of an input raster. 
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GET CONTAINING DIRECTORY 

 

Gets the containing directory of a file or directory. This can have similar utility as Get Basename above. 

GET DEFAULT BAND SELECTION 

 

Use the Get Default Band Selection operator to find the default band combination to use for visualization of the 

input Raster. The default band combination is derived either from the Metadata provided or from preferences. The 
input for the Context port indicates what type of visualization the output is needed for. For the Context port, you 
can choose from Multispectral, Panchromatic, Thematic, or Relief. If the Context is Multispectral, the output 
will have 3 bands in the order Red, Green, Blue. If the Context is Panchromatic, Thematic, or Relief, the output 

will have 1 band. 

GET DRA PARAMS 

 

Dynamic Range Adjustment (DRA) is a technique used to perform tonal processing of raw image data, mapping it 
from the dynamic range of the sensor to that of a well-defined metric. Once mapped, standardized enhancement 
processing can then be applied. The DRA algorithm permits the adjustment and optimization of an image’s 
dynamic range so that the maximum amount of information can be obtained from all portions of the tonal range. 
The algorithm will clip information beyond the desired range. DRA is usually applied to only a single band of data, 
but can also be applied to multispectral data on a band by band basis, although it is recommended to use a band-
dependent (color preserving) technique, such as is provided by the Multispectral DRA Stretch operator, for 
multispectral data. Use the Get DRA Params operator to acquire the necessary inputs to use with the DRA Stretch 
operator. 

GET GEOMETRIC MODEL INFO 
 

 

Returns information about the geometric model associated with an image or a coordinate referencing operation. 
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GET INDEX FOR CLASS NAME 
 

 

Determines the index (band ratio) appropriate for identifying pixels of a specified class (such as vegetation or 
water). 

GET INTERACTIVE CHAIN 

 

Use the Get Interactive Chain operator to determine the required input for the operators: Get TTC, Get MTFC, 

and DRA Selector. 

The output SIPS InteractiveChain string provides an indicator of what default parameters (usually based on a 
determination of what sensor captured the image) should be used for further processing of the image in 
association with use of the operators listed above. The output for the Get Interactive Chain operator is based on 

the Metadata of the input Raster. 

GET MTFC 

 

The Get MTFC operator identifies a default MTFC (Modulation Transfer Function Compensation) convolution 

kernel file (.ker) from a database of possible such kernel files, based on input values. The MTFC kernel files are 
formatted in the NGA Softcopy Image Processing Standard (SIPS) kernel format and a database of such files is 
provided in <IMAGINE_HOME>\etc\ sips\mtfc. You can configure alternative databases of kernel files using a 
Preference. Convolution kernels are used to calculate a weighted average of the value of each pixel with the 
values of the surrounding pixels and the MTFC kernels are specifically used to sharpen image detail in this 
manner. 

GET SIGNATURE 
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Gets a signature from a signature list by its name. A signature is a set of data that defines a training sample, 
feature space object, or cluster. The signature is used in the classification process. Each classification decision 
rule (algorithm) requires some signature attributes as input. These are stored in the signature file. 

 

GET TTC 

 

The Get TTC operator identifies the correct default TTC (Tonal Transfer Curve) lookup table (LUT) from a 

database of possible such lookup table files, based on the input values. The TTC lookup files are formatted in the 
NGA Softcopy Image Processing Standard (SIPS) LUT format and a database of such files is provided in 
<IMAGINE_HOME>\etc\sips\ttc. Configure alternative databases of LUT files using a Preference. The purpose of 
these TTC LUTs is to enable the mapping of input raster values to new values based on the LUT curve shape you 
want. 

GROUND TO IMAGE 
 

 

Applies Ground / Map Space to Image Space transformation on a list of coordinates specified in port FeaturesIn 
using the Geometric Model of the raster image specified in port Raster. If the geometric model is 3D (that is, the 
elevation value is used in the model), you can provide an elevation file (using port ElevationFilename) or constant 
elevation value (using port ConstantElevation) and elevation units (using port ElevationUnits) to the operator to 
replace the model's original elevation file or constant elevation value. 

IMAGE PAIR 

 

This operator creates an image pair from two overlapping rasters that have embedded 3D sensor models. It 
compares two rasters. If the overlap between them is greater than the minimum specified, computes key image 
pair information such as the initial ground point, left and right map footprints, overlap boundary and overlap 
percentage. This operator requires both raster inputs to have been calibrated with 3D sensor models. 
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IMAGE PAIR INFORMATION 

 

This operator provides access to the properties of an ImagePair object. 

IMAGE PAIR TO GROUND 

 

This operator applies Image Space to 3D Ground/Map Space transformation on a pair of Features representing 
coordinates specified in left and right image space using the geometric models of the image pair specified in port 
ImagePair. The results are the 3D ground coordinates. Note that attributes belonging to the Features connected to 
port LeftFeatures are transferred to output FeaturesOut. 

IMAGE TITLE 

 

Uses the Metadata from a dataset to construct a title string that can be used to properly label a view of a dataset. If 

the required metadata is not present, the resulting Title is just the base dataset reference. 

IMAGE TO GROUND 

 

Applies an Image Space to Ground / Map Space transformation on a list of coordinates specified in port 
FeaturesIn using the Geometric Model of the raster image specified in port Raster. If the geometric model is 3D 
(that is, elevation value is used in the model), you can provide an elevation file (using port ElevationFilename) or 
constant elevation value (using port ConstantElevation) and elevation units (using port ElevationUnits) to the 

operator to replace the model's original elevation file or constant elevation value. 
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IMAGINE SIGNATURE INFORMATION 

 

Extracts the signature parameters from a signature. These include items describing the signature as well as how 
the signature was created. A signature is a set of data that defines a training sample, feature space object, or 
cluster. The signature is used in the classification process. Each classification decision rule (algorithm) requires 
some signature attributes as input. These are stored in the signature file. 

 

INT INPUT 

 

Creates an Int (signed integer). Double-click the operator to open its configuration dialog. The Int Input dialog 
opens. 

ITERATOR 

 

The Iterator operator takes the items off of a List and puts each one through a sub-model the user builds inside 
the operator. This is done for each item in the List once. 

For example, in this spatial model 

 

…the Iterator applies the following sub-model 
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…so that, no matter how many bands the Input MS Image has, the Zonal Mean operation (which only accepts a 
single band input) is applied to each band. 

LINE OF SIGHT 

 

Calculates the visibility along a line between an observer point and a target point with associated elevations above 
ground level using elevation data. It will also return a flag indicating whether or not the target point is visible from 
the observer point. 

LIST 

 

The List operator takes in n items and either adds them onto an existing List or creates a new List of those items. 

The Value ports can be added or removed down to one Value port. 
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MEASURE ANGLE 

 

Computes the angle between two line segments from a feature. The input FeatureIn can be of any type but the 
operator will only produce a non-NULL result for a polyline with at least three vertices. The coordinates of the first 
three vertices are used to define two line segments with a common coordinate and the angle between the 
segments is computed and written to the attribute provided by the AttributeName port. 

MEASURE AREA 

 

This operator computes the area for each polygon in the input Features. The area of each applicable feature of the 
input Features is calculated and stored in a column of the output Features. The value placed into each field will be 
the calculated value of the area in the horizontal units of the input Features CRS unless it is geographic in which 
case it will be in meters. 

MEASURE AZIMUTH 

 

Computes the Azimuth (in degrees) of a line segment defined by two points. 

Azimuth is computed from first to second point and written to the attribute specified by AttributeName port. 
Azimuth ranges from 0 to 360 degrees and starts from North as 0 increasing clockwise (East - 900,, South - 1800, 
West - 2700 ).  

Use the FeaturesIn port to specify the feature for which Azimuth will be computed for. The FeaturesIn port 

accepts any type of feature either in an image coordinate system or ground coordinate system.  

The operator will return NULL if the input feature is not a polyline. For a polyline feature, the first two points of the 
polyline are used to calculate the azimuth.  

MEASURE CENTER 

 

This operator computes the center of each of the features and stores it in an attribute column. 
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MEASURE FITTED ELLIPSE 

 

Computes the parameters of an ellipse for each of the input features and stores them as attributes. This capability 
is frequently used to generalize and highlight features which have been automatically extracted from imagery. 

Parameters of an ellipse are calculated and stored in attribute columns of the output Features. Parameters include 
the ellipse's center point, major and minor axis lengths, major axis orientation in the form of bearing (0 degrees 
aligned with +Y (or North) axis with +rotation = clockwise), perimeter, and area in the horizontal units of the input 
Features CRS. If the CRS is geographic, meters will be used for the major axis, minor axis, and perimeter; and 
square meters for the area. The computation can be constrained to fit a circle (a special case of an ellipse where 
the major and minor axis are equal and the orientation = 0) via setting an input flag 

MEASURE FITTED RECTANGLE 

 

Computes the parameters (center, size, orientation, and area) of the best fit rectangle for the geometry 
interpretation of each input feature, saving the results in attribute columns of the output features. 

Parameters of the best fit bounding rectangle of each input feature are calculated and stored in attribute columns 
of the output Features. Input should be 2 or more points nominally located on the sides of the desired rectangle. 
The computed parameters, center point, length (long side), width, axis orientation in the form of bearing of the long 
side (0 degrees aligned with +Y (or North) axis with +rotation = clockwise), perimeter, and area in the horizontal 
units of the input Features CRS are added as attributes to the output Features. 

MEASURE GRID NORTH ANGLE 

 

This operator computes the angle to the grid North direction at a point in an image. 

MEASURE HEIGHT FROM RELIEF 

 

This operator computes the height of a point based on image displacement. 
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The first two points of each feature in the given Features are taken to be a point on the ground in the image and a 
point directly above that. For example, the lower and upper corner along the edge of a building. Using the 
assumption of common ground X and Y the sensor model associated with the given raster is used to compute the 
height needed to cause the measured displacement. 

MEASURE LAYOVER ANGLE 

 

This operator computes the angle to the direction of the height displacement at a point in an image. 

MEASURE LENGTH 

 

This operator computes the length of each of the features and stores it in an attribute column. 

MEASURE PERIMETER 

 

This operator computes the perimeter of each of the features and stores it in an attribute column. 

MEASURE POLYGON 

 

Computes the parameters of a polygon for each of the features and stores them as attributes. Parameters include 
the polygon's centroid, perimeter, and area in the horizontal units of the input Features CRS. 

MEASURE TRUE NORTH ANGLE 

 

This operator computes the angle to the true North direction at a point in an image. 
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MERGE FEATURES 

  

Merges the touching geometries of input features (i.e. dissolves any shared boundaries). There is a logical "and" 
between the attribute fields on which the merging is to occur. In other words, for two features to be merged, they 
must "match" on all fields. The Spatial Relation “touch” is used for merging the geometries. 

MODIFY DICTIONARY ITEM 

 

The Modify Dictionary Item operator modifies value(s) of requested dictionary item(s) from the specified Dictionary 
object. The original DictionaryIn is not modified. Instead, this operator creates a clone of the original DictionaryIn 
and the modification is made to the clone. The output DictionaryOut is the modified Dictionary clone. 

MULTI FILENAME INPUT 

 

The Multi Filename Input operator outputs a List of file names specified either by a single Directory and a Wildcard 
(a String), an input List of filenames, or both. Supported wildcard characters are the standard Windows wildcards 
"*" and "?". For example, the wildcard string "w*.img" would put all the files that start with a "w" and have the 
extension "img" into the output list. 

MULTISPECTRAL DRA STRETCH 

 

Use the Multispectral DRA Stretch operator to apply a band-dependent Dynamic Range Adjustment (DRA) 
stretch for a multispectral Raster based on the inputs from the DarkPoint and BrightPoint ports. A DRA is a 
linear remapping of the pixel data of a Raster that results in a change in the image's contrast and brightness. The 
band-dependent nature of this algorithm means that it is a color-preserving technique (the relative positions of the 
band histograms remain similar). For non-multispectral images, use the DRA Stretch operator. 
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NTH ITEM 

 

The Nth Item operator references a single item from a list, by index number. 

NUM ITEMS 

 

Use the Num Items operator to find how many items you have in the input List. 

ORTHO ERROR 

 

The Ortho Error operator computes how accurate the orthorectification of the input Raster will be based on the 
input coordinate operation, information used to transform points from one CRS (Coordinate Reference System) to 
another. The results are placed in the file named on the ErrorFilenameIn port. This operator uses CE90 (Circular 
Error at 90% confidence) and RMSE (Root Mean Square Error) to determine how accurate the orthorectifcation is 
in comparison to how accurate it was expected to be. 

ORTHORECTIFY 

 

The Orthorectify operator maintains an image's cardinal orientation while aligning the pixels based on the 
coordinated reference system (CRS) of the input Raster. The ports XCellSize and YCellSize determine the size of 
the output grid of the image. If left blank, the output grid will be the same size as the input grid. 

PATH EXISTS 
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The Path Exists operator determines if the input filename or directory exists or not. If it does, then a Boolean of 
true is set on the PathExists port. If not, then false is set on the port instead. 

PROFILE 

 

Creates a set of points that represent a terrain profile along a feature such as a line or polygon for a given DEM. 
Each point has attributes representing the slope, distance in 2D, and distance in 3D, calculated from the previous 
point (ordered by the "ID" attribute). 

REGULAR EXPRESSION SEARCH 

 

The Regular Expression Search operator searches using a String for a regular expression match. It uses the Boost 
regex Library's Perl regular expression syntax for the regular expressions in StringIn. 

REMOVE ELEVATION SPIKES 

 

This operator detects and removes spikes/sinks in a raster terrain dataset. Spike/sink removal is performed by 
computing neighborhood statistics and detecting large deviations of the center pixel from the neighborhood robust 
value span. Pixel values that are detected as a spike/sink are replaced with values that are computed from the 
surrounding pixels by using a DCT (discrete cosine transform) based algorithm. 

REMOVE EMPTY ITEMS 

 

The Remove Empty Items operator removes all NULL, or empty, items from the input List. The resulting List is set 
on the ListOut port. If the operator does remove any items, the size of the output List will be different than the input 
List. 
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RENDER MAP COMPOSITION 

 

Creates a raster dataset from a map composition (.map) file. 

REQUIRE CONDITION 

 

The Require Condition operator determines if a set condition is met. If the condition is not met, the execution fails 
and a failure message is given. 

RPC GENERATOR 

 

Use the RPC Generator operator to generate the parameters for a Rational Polynomial Coefficient (RPC) model 
based on the input Raster file. An RPC model is a ground-to-image model which is used during photogrammetry 
processing. 

SET TERRAIN HEIGHT 

 

This operator applies a constant Z value to selected areas of a raster terrain. The areas to be affected are selected 
by supplying features. 

SIGNATURE INPUT 

 

Reads all of the signatures from an ERDAS IMAGINE Signature file. Often used in combination with Get Signature 
to retrieve a specific named signature from the signature list. 
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SIPS KERNEL INPUT 

 

The SIPS Kernel Input operator is intended to take an input Kernel file formatted in the NGA Softcopy Image 
Processing Standard (SIPS) kernel format and convert it to a Matrix object usable in Spatial Modeler. The resulting 
matrix is generally intended for use as a convolution kernel. Convolution kernels are used to calculate a weighted 
average of the value of each pixel with the values of the surrounding pixels. 

SIPS LUT INPUT 

 

The SIPS LUT Input operator is intended to take an input SIPS LUT file formatted in the NGA Softcopy Image 
Processing Standard (SIPS) LUT (*.lut) format and convert it to a Table object usable in Spatial Modeler. You can 
use the resulting Table object as a lookup table for imagery, including use with the DirectLookup operator. 

SMOOTH ELEVATION 

 

Performs an edge preserving smoothing by using bi-lateral recursive IIR (infinite-impulse-response) filters. Bi-
lateral weighting of the neighborhood values is based on 3D location proximity (proximity in grid space and value 
proximity in elevation range) such that elevation values closer to an input pixel exert higher influence on the output 
value. 

SPLIT STRING 

 

The Split String operator splits a given String based on the input delimiters. Delimiters are a String of characters, 
each of which is used to determine where to separate a String into smaller Strings. In this operator, all the 
characters in the Delimiter port are a delimiter. The Split String operator removes the delimiters and separates the 
String into smaller Strings, on either side of each delimiter. 
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STEREO VIEW GEOMETRY 

 

Provides the basic information needed for a stereo client to project the left and right images into a stereo view. 

STRING INPUT 

 

Creates a String.  

SUBSET SAR IMAGE PAIR 

 

This operator subsets a SAR image pair to a common bounding box extent. 

SUBSTRING 

 

The Substring operator takes in a String and outputs a substring based on a starting location and the length of 

the desired substring. 

TERRAIN BIAS 

 

Applies bias (a constant Z) to selected areas of a raster terrain. Selection areas are specified as polygon features 
via the Features port. If there are multiple polygon features, the bias will be applied to each polygon feature.  



 

New Technology 

 

May 26, 2016 43 

TERRAIN BULLDOZER 

 

Automatically bulldozes a raster terrain based on a breakline, interpolation distance and geomorphic edit type. The 
Features port specifies the path to be bulldozed, while the GeomorphType and InterpolationDistance determine 

the type of the Bulldoze type and the extent to be bulldozed on either side of the path respectively. 

TERRAIN THIN 

 

This operator thins a terrain file by removing redundant elevation points, or those deemed not important to the 
underlying surface. One of two optional algorithms can be chosen: thin points based upon an error threshold 
distance or reduce the overall number of points based on a percentage value. 

TEXT FILE INPUT 

 

The Text File Input operator reads text from a text file and outputs the text as a String. This operator also has the 
option to limit the number of characters that are read into the String, as well as to skip a number of characters from 
the start of the file. 

TO STRING 

 

Creates a data type-specific string representation of data. 

TRIDICON SGM 

 



 

New Technology 

May 26, 2016 44 

This operator extracts a point cloud from a stereo image pair through the Tridicon Semi Global Matching (SGM) 
algorithm. The operation uses a pair of stereo images which are already epipolar resampled and in uncompressed 
8-bit TIF raster format to generate a point cloud output. 

UNSIGNED INPUT 

 

Creates an Unsigned (non-negative integer).  

WARP TO VIEWPORT 

 

Warps a portion of a raster to fit a given viewport geometry. The raster has to be an oriented image (image with 3D 
sensor model). The operator will clip, scale, rotate and resample the raster to fit a stereo viewport. 

REPLACED OPERATORS IN SPATIAL MODELER 
The following table represents operators which existed in ERDAS IMAGNE 2015 (the left column) but which have 
been updated with new capabilities and renamed in ERDAS IMAGINE 2016 (the center column). 

Spatial models created in ERDAS IMAGINE 2015 (or prior) using the old, deprecated operators will generally still 
work in ERDAS IMAGINE 2016 (i.e. they are considered viable), but it is highly recommended that the models be 
re-worked to use the newer, supported operators. 

 

Operator in 2015 Operator in 2016 Category in 2016 

Buffer Buffer Zones Features 

Vector Input Features Input Features, Input 

Shapefile Output Features Output Features, Output 

Attribute Filter Filter By Attributes Features 

Warehouse Attribute Update Update Attribute Features 

Spatial Query Filter By Geometries Features 

Warehouse Attribute Table Select Attribute Features 

Rasterize Convert To Raster Features 

Warehouse Output Features Database Output Features, Output 

Add Bias Point Cloud Bias Elevation Point Cloud 

Classifier Point Cloud Classify Point Cloud 
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Delete Points Point Cloud Delete Points Point Cloud 

Merger Point Cloud Merge Point Cloud 

Point Cloud Volume Point Cloud Measure Volume Point Cloud 

ReClass Point Cloud Reclassify Point Cloud 

RGB Encode Point Cloud Encode Point Cloud 

Set Constant Z Point Cloud Set Constant Elevation  Point Cloud 

Subset  Point Cloud Subset Point Cloud 

Select By Point Cloud Build Selection Criteria Point Cloud 

 

GENERAL SPATIAL MODELER 
 

PORT INPUT (AND OUTPUT) 
 
In prior versions of Spatial Modeler it was generally not clear which ports would be treated as variables when the 
Spatial Model was executed in Batch, or which would appear as prompts when added to the ribbon interface. 
 
In order to make this clear, it is now necessary to use the Port Input operator (and occasionally the Port Output), 
connected to any port which is expected to be filled in by the user when the model is executed. These Port Inputs 
may still have default values defined for them (so that the user does not necessarily need to provide a value every 
time), but only if a Port Input is connected will the value be prompted for. 
 
For example, when the following model is run.  
 

 
 
…a dialog will be automatically generated which looks like this 
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…because there are five Input Ports (which have been renamed to reflect what they are expecting to be input) 
defined in the model and only those five values are prompted in order for the model to be successfully executed. 
 
Empty ports such as the Ignore port on the Principal Components operator, or the (f32) data type port on Raster 
Output, are not prompted for because they have no Port Input operator connected to them. 
 

PORT INPUT ORDERING 
 
Another aspect of the auto-generated Run dialog which has been clarified in this release is the order in which the 
ports are listed in the dialog. Previously they were simply presented in the order they were added to the model, 
which could result in some confusing arrangements of parameters. 
 
A capability is now provided to reorganise the ordering (without needing to delete and re-add the ports). With no 
operators selected in the Spatial Model Editor canvas go to the Properties panel (usually situated at the lower right 
of the Spatial Modeler interface). If no operators are selected the Properties panel shows the properties of the 
entire model and  shows any Port Inputs in the order in which they will be presented in the auto-generated Run 
dialog. If this is not the desired order, simply right-click over a row in the Properties CellArray and select one of the 
Move options. Repeat until the entries are in the desired order. 
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ANNOTATING SPATIAL MODELS 
 

As well as the ability to rename Operators and to add Descriptions to Port Inputs to assist in understanding what a 
model is doing, the ability has been added to include text annotation onto models. 

 

OBFUSCATION 
In order to assist in protecting the Intellectual Property inherent in a Spatial Model which might be created by a 
particular company, Spatial Models can now be “encrypted” into a form which can still be executed (or embedded 
into a larger Spatial Model as a sub-model) but which cannot be displayed in their original form in the Spatial 
Model Editor. Consequently, the precise algorithm being applied by the model is hidden from other users. 
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SHARE SPATIAL MODELS WITH SMART M.APP 

 

Smart M.Apps are targeted, lightweight map applications that solve real business problems. Hexagon Smart 
M.Apps are created using a modern, cloud-based framework called the M.App Studio. M.App Studio is for 
Hexagon Geospatial development partners and geospatial entrepreneurs who wish to develop Hexagon Smart 
M.Apps. With or without programming skills, M.App Studio can be used to fuse dynamic content with purpose-built 
analytics, to provide insightful information services.  

The M.App Studio is an interactive, web-based spatial workshop for designing, building and publishing your 
Hexagon Smart M.App to the M.App Exchange. The M.App Exchange is the cloud-based store and central 
repository for the Hexagon Smart M.App. 

Spatial Modeler provides a tool to directly upload Spatial Models from the Spatial Model Editor into your M.App 
Studio, from where they can be further edited using the Spatial Workshop or used immediately to create analytics 
within a new Smart M.App. 

SAVE AS IMAGE FROM IMAGE CHAINS 
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After an image has been displayed and styled using the File / Open / Raster as Image Chain… option it can now 
be saved to an output image which preserves this styling. 

SOFTCOPY IMAGE PROCESSING STANDARD (SIPS) IMAGE 
CHAINS 
 

As mentioned in the section of this document dealing with new Spatial Modeler operators, several capabilities have 
been added to the Image Chain display modes which enable display of image data following the Softcopy Image 
Processing Standard (SIPS). SIPS specifies processes necessary for standardised, consistent image processing 
and exploitation.  

As well as non-interactive processes, such as RSET generation, SIPS defines interactive processes which should 
be applied to input data prior to its display to the screen. These include sensor-specific defaults as well as specific 
options which can be subsequently manipulated to fine tune the image display. 
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Such options include Dynamic Range Adjustment, Sharpness filters and Tonal Transfer Curves. 

In addition to the necessary tables and definitions for displaying commercial satellite imagery in the general 
distribution of ERDAS IMAGINE, the IMAGINE Defence Productivity Module (DPM) adds support for other 
sensors. 

LAGRANGE RESAMPLING 
 

One option added for SIPS support is a new resampling technique called LaGrange resampling. This technique 
applies a four-point interpolation using LaGrange coefficients in order to preserve a high degree of positional 
fidelity while also minimising execution time and preserving the modulation transfer function of the image when 
downsampling. 

This technique can not only be applied the 2D View for interactive display, it can also be used when ortho 
resampling imagery and when applying other processes that require image resampling, such as when pan 
sharpening imagery in the Spatial Modeler. 

NEW SENSORS AND FORMATS 

SENTINEL-1 
Sentinel-1A SAR imagery can be directly read in both standard and burst forms. 
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SENTINEL-2 
The capability has been added to read Sentinel-2 raster format data. Like Sentinel-1, Sentinel-2 is part of the 
European Space Agencies (ESA’s) Copernicus program aimed at providing “accurate, timely and easily accessible 
information to improve the management of the environment, understand and mitigate the effects of climate change 
and ensure civil security”. Sentinel-2, launched on 23 June 2015, is designed to deliver high-resolution optical 
images for land services such as land management, emergency response, security and climate change. 

Partnership between ESA and the USGS provides for the public access and redistribution of global acquisitions of 
the European Union's Sentinel-2 data at no cost through secondary US-based portals (such as EarthExplorer), in 
addition to direct user access from ESA’s Scientific Hub. 

The Sentinel-2 Multispectral Instrument (MSI) samples 13 spectral bands at three different spatial resolutions: The 
four main visible and near-infrared Sentinel-2A bands have a spatial resolution of 10 meters, while its “red-edge” 
(red and near-infrared bands) and two shortwave infrared bands have a 20-meter spatial resolution. The 
coastal/aerosol, water vapor, and cirrus bands have a spatial resolution of 60 meters. 

ERDAS IMAGINE provides a direct-read capability for the SAFE format that Sentinel-2 data is distributed in. This 
capability will, by default, treat all 13 bands as a single image at a 10m resolution. However the Sub-Images tab of 
the File Chooser also provides access to the data at differing resolutions and in differing groupings. 
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GÖKTÜRK-1 
Göktürk-1 is a high resolution earth observation satellite designed and developed for the Turkish government. 

For orthorectification, both RPC and Rigorous sensor models are provided. 

KAZEOSAT-1 & -2 
KazEOSat-1 and -2 are satellites developed for Kazakhstan’s space program.  

KazEOSat-1 is a High Resolution Earth Observation Satellite System similar to the SPOT-6 / -7 platform providing 
1m Panchromatic data and 4m, 4-band Multispectral (Red, Green, Blue, NIR) data in DIMAP v1 format. 

KazEOSat-2 is a Medium Resolution Earth Observation Satellite System similar to the Disaster Monitoring 
Constellation (DMC) platforms providing 6.5m, 5-band Multispectral (Blue, Green, Red, Red Edge & NIR) data in 
DIMAP v1 format. 

For orthorectification, an RPC sensor model is provided for KazEOSat-1. For KazEOSat-2 both RPC and Rigorous 
Orbital sensor models are provided. 

DMC-3 
The DMC-3 constellation of satellites (also referred to as TripleSat Constellation-2) are High Resolution Earth 
Observation Satellite Systems with 1m Panchromatic data and 4m, 4-band Multispectral (Blue, Green, Red, NIR) 
data in GeoTIFF format. The imagery can be read using the GeoTIFF raster format reader. 

WCS / WMS RE-WRITE AND DIRECT ACCESS 
Rather than forcing customers to utilize the GeoSpatial Explorer (GSX) dialog to identify WMS or WCS services for 
display in ERDAS IMAGINE, access is now provided through direct selection of the relevant URL by choosing File 
/ Open / Web Service. 
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This display of WMS is provided through a custom layer and consequently is faster to pan and zoom than in 
previous versions, as well as providing access in the Table of Contents to all layers provided by the URL.  

 

NITF FORMAT 
The NITF format has evolved recently to cover new capabilities such as multi-segment data. Efforts have been 
made in ERDAS IMAGINE 2016 to support these changes to the format. 

The Shapefile Extraction tool has also been expanded to support additional vector feature layers which may be 
stored in these newer NITFs. 
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FLOAT DATA DEFAULTS TO 32K BINS 
To assist in better default display quality of some Floating Point imagery (specifically, data with heavily skewed 
histograms), the number of bins used to calculate linearly binned statistics (which is what is used for Float data 
types) has been increased from 256 to 32,768. This can be controlled through a Preference if more (or less) fidelity 
is required. 

DIRECT-WRITE TO ERS BIL FORMAT 
To improve interoperability between ERDAS IMAGINE and ERDAS ER Mapper the capability has been added to 
directly write data in the ER Mapper.ERS BIL format. Applications which support this are Spatial Modeler, the 2D 
View, and MosaicPro. 

PROJECTED COORDINATE SYSTEMS 
 

Added support for 800+ Coordinate Reference Systems including, among others: 

 NAD 1983 (2011) StatePlane California III FIPS 0403 (US Feet) 
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 Israeli Projected CRS  EPSG:6991 

 Five EPSG projections in Pulkovo 1942(58)  

 Minnesota County Projection 

 Iowa Regional Coordinate System 

 ESPG 8.8 & 8.9 

 

POINT CLOUD  
 

LAS 1.4 
The LAS format, owned by ASPRS, is a standard for LIDAR or other point cloud data records. ERDAS IMAGINE 
2016 adds support for LAS 1.4. 

STYLING PERSISTENCE 
Displays styling of LAS data such as point size, display type and display color can now be persisted to a 
symbology file.  The point cloud data will be rendered based on the style saved in the symbology file.   

RESERVED AND USER DEFINED CLASSES 
Reserved and user-defined classes are distinctly identified in point cloud data. 

Z SCALING IN 3D VIEWER 
A Z exaggeration can be applied to the data loaded in the 3D point cloud viewer using the Z Scale in display group 
of the point cloud tab.  

3D MEASUREMENT 
Measurements can now be done in the 3D point cloud viewer. Measurements include point measurement to get 
XYZ coordinate of the point, length measurement and height of point above a specified terrain model.   

MOSAICPRO IMPROVEMENTS 
 

ADDED NEW OUTPUT FORMATS  
MosaicPro output formats are expanded to include NITF, PNG, and ERS formats. 

MASKED BASED NODATA LAYER SUPPORT FOR JPEG 2000 OUTPUT 
Mask based Nodata layer support is added to JPEG 2000 output. 

RADAR 
 

SENTINEL-1 SUPPORT IN RADAR ANALYST WORKSTATION 
Sentinel-1 SAR imagery can be directly displayed and automatically geocoded into the 2D View. 
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It can also be processed using the Radar Analyst Workstation. 

SENTINEL-1 SUPPORT IN INTERFEROMETRY 
Sentinel-1 imagery is supported via full scene Interferometric CCD workflow, as well as providing burst sub-scene 
InSAR and DInSAR processing. 

POLARIMETRY UTILITY 
Several new multi-polarimetric color-composite displays can now be selected 

 Pauli Basis produces an image wherein R(ed) is calculated as HH-VV, G(reen) is calculated as HV+VH 
and B(lue) is calculated as HH+VV 

 Polar Ratio produces an image wherein R(ed) is calculated as HH/(VV+HH), G(reen) is calculated as 
VH/(VV+VH) and B(lue) is calculated as VV/(HH+VV). A Polar Ratio image is frequently used for 
vegetation mapping purposes. 

 Polar RGB produces an image wherein R(ed) is HH, , G(reen) is calculated as HV+VH and B(lue) is VV 

AUTOENHANCE UTILITY 
Radar AutoEnhance creates an RGB image from a grey-scale radar (Magnitude) image by applying three different 
enhancements to the input image and using each as a layer in the product image. This functionality also exists as 
a Real-Time Display enhancement in the Radar Analyst Workstation. 

MOSAIC SERIES CCD WORKFLOW  
The Mosaic Series CCD workflow is designed to automate generating Coherence Change Detection images over 
larger regions. This is done by automatically mosaicking contiguous two-image CCD layers. The InSAR-pair 
images are entered and automatically geographically referenced. The analyst can then define the desired 
processing regimen (Template) and output products. After processing, the various products can be automatically 
mosaicked. The entire process is stored as a CCD Project file and can be accessed or updated in future as more 
images become available. This functionality is specifically designed to support Sentinel-1 data, but data from any 
sensor can be used equally well. 

TIME-SERIES CCD REDESIGN 
The Time Series CCD dialog is designed to automate Coherence Change analysis. The InSAR-pair images are 
entered and automatically date sequenced. The analyst can then define the desired processing regimen 
(Template) and output products. After processing, the products can be automatically displayed in the 2D View for 
analysis. The entire process is stored as a CCD Project file and can be accessed or updated in future as more 
images become available. 

With this release the workflow has been redesigned to co-register all images to common Reference image. 

ZONAL CHANGE DETECTION 
 

the Zonal Change Detection workstation provided with IMAGINE Advantage has undergone several improvements 
based on customer feedback, including 

IMAGES WITH DIFFERENT BANDS 
Images that have different number of bands (layers) can be used as Before (older) and After Images (newer) 
Images. 
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FILTERING 
Changes that are not relevant to a project can be excluded. Filtering is currently supported for Vegetation-only 
changes and Non-Vegetation only changes. 

SHAPEFILE OUTPUT REPORT 
A shape file report for each region that has been processed and reviewed is generated and saved in the project 
folder.  The status for each zone in the region is reported as attributes of the shape file. 

ORIMA 
 

SIZE OF CORRECTION GRID EXTENDED TO HANDLE LARGER FRAME SENSORS 
The maximum number of grid points is extended from 625 to 2500. This change is geared for large sensors (such 
as DMCII and DMCIII) that need more grid points to get better accuracy.   

DISPLAY FUNCTION ENHANCED TO HANDLE MORE THAN 250,000 OBJECT POINTS 
The maximum number of points that can be displayed on object windows (East-North, East-Height and North-
Height) is enhanced to more than 250,000 object points. This is beneficial in large blocks with multihead sensors, 
such as the Leica RCD30 Oblique Camera System.  

SIMPLIFIED ALGORITHM FOR BLUNDER DETECTION IN CAP-A 
CAP-A offers a new simplified algorithm for blunder detection. When this option is selected CAP-A will use a 
parallel algorithm and utilize all available cores of the processor and therefore will run much faster. In most cases 
the fast simplified algorithm will deliver satisfying results. In cases where the statistical values are needed use the 
fast algorithm to first remove blunders and make a final adjustment with all statistical values. 
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SYSTEM REQUIREMENTS 

ERDAS IMAGINE (INCLUDING ERDAS ER MAPPER, IMAGINE 
PHOTOGRAMMETRY AND ORIMA) 

Computer/ Processor 

64-bit: Intel 64 (EM64T), AMD 64, or equivalent  

(Multi-core processors are strongly recommended) 

Memory (RAM) 8 GB minimum, 16 GB strongly recommended, especially for 64-bit systems 

Disk Space 

 4 GB for software 

 7 GB for example data 

Data storage requirements vary by mapping project
1
  

Operating Systems 
2, 3

 

 Windows
®
 7 SP1 or higher, Professional and Ultimate (64-bit) 

 Windows
®
 8  (Standard),  Professional and Enterprise (64-bit) 

4
 

 Windows
®
 8.1 (Standard),  Professional and Enterprise (64-bit) 

4
 

 Windows 10 Pro (64-bit) 
4
 

 Windows Server
®
 2008 R2 SP1 (64-bit) 

 Windows Server 2012 R2 (64-bit)  

Software 

 OpenGL 2.1 or higher (this typically comes with supported graphics cards
5
) 

 Adobe
®
 Reader

®
 7 or higher 

 Internet Explorer
®
 7 and higher with JavaScript enabled, or Firefox

®
 3 and higher with 

JavaScript enabled 

 Java Runtime 1.7.0.80 (optional install, required for Web Process Service (WPS) 
publishing to APOLLO Professional. IMAGINE Objective requires JRE, but can utilize any 
installed and configured JRE of version 1.7.0.80 or higher) 

 Python 3.4 (optional install if Python is to be used in Spatial Modeler. 32-bit is required for 
Spatial Model Editor, and 64-bit is required for background processing) 

 Microsoft DirectX
®
 9c or higher 

 .NET Framework 4.0 

 MSXML 6.0 

 Oracle Instant Client and Oracle Data Provider for .NET (Required for Oracle Feature 
Proxy access) 
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Recommended Graphics 
Cards 

 NVIDIA
®
 Quadro

®
 K5200, K4200, K2200, K420 

6
 

 NVIDIA Quadro K5000, K4000, K600 
6
 

 

Recommended Stereo 
Display Monitors 

 120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit 
7
 

 

Peripherals 

All software installations require: 

 One Windows-compatible mouse with scroll wheel or equivalent input device  

 Printing requires Windows-supported hardcopy devices 
8
  

Software security (Intergraph Licensing 11.13.2) requires one of the following: 

 Ethernet card, or  

 One USB port for hardware key 

Advanced data collection requires one of the following hand controllers:
 9
 

 TopoMouse™ or TopoMouse USB™ 

 Immersion 3D Mouse 

 MOUSE-TRAK  

 Stealth 3D (Immersion), S3D-E type, Serial Port 

 Stealth Z, S2-Z model, USB version 

 Stealth V, S3-V type (add as a serial device) 

 3Dconnexion SpaceExplorer mouse 
10

 

 EK2000 Hand Wheels 

 EMSEN Hand Wheels 

 Z/I Mouse 

ArcGIS and GeoMedia 
Interoperability 

 ERDAS IMAGINE 2016 can be safely installed on a computer that has GeoMedia 2016 
installed.  

 ERDAS IMAGINE 2016 requires GeoMedia 2016 for live linking. 

 ERDAS IMAGINE can interact with both types of personal Geodatabases (*.mdb and 
*.gdb). 

 ERDAS IMAGINE can be safely installed on a computer that has ArcGIS® versions 10 
through 10.3. 

 ERDAS IMAGINE and IMAGINE Photogrammetry can interact with ArcGIS Server 10 
Geodatabase servers (ArcSDE). To read or interact with an Enterprise Geodatabase, you 
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must either:  

o Install and license the appropriate version of ArcGIS for Desktop versions 10 
through 10.3, OR  

o Install the IMAGINE Geodatabase Support (based on ArcEngine 10.1), which 
requires no license 

ERDAS IMAGINE SYSTEM REQUIREMENTS NOTES 
1
 Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity. 

Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves 
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk drives are 
subject to network limitations.  

2 
Server Operating Systems are not supported for IMAGINE Photogrammetry, ORIMA or ERDAS ER Mapper. 

3
 The 3D stereo viewing and peripheral requirements of IMAGINE Photogrammetry limit its operating system 

options.  

4
 ERDAS ER Mapper is not supported on Windows 8 or 10. It is considered viable on Windows 8.1. 

5
 Windows provides a generic OpenGL driver for all supported graphics cards. However, an OpenGL-optimized 

graphics card and driver are recommended for these applications.  

6
 Graphics cards certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be 

compatible, but are not certified in the current version. 

7
 Stereo Monitors certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be 

compatible, but are not certified in the current version. 

8
 HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.  

9
 Stealth S-Mouse (S2-S model) and MOUSE-TRAK are the only supported hand controllers in Stereo Analyst

®
 for 

ERDAS IMAGINE.  

10
 3Dconnexion SpaceExplorer mouse is supported in IMAGINE Photogrammetry. 

 

PRO600 

Computer/ Processor 

64-bit: Intel 64 (EM64T), AMD 64, or equivalent  

(Multi-core processors are strongly recommended) 

Memory (RAM) 4 GB minimum, 8 GB strongly recommended 

Disk Space 

 1 GB for software 

Data storage requirements vary by mapping project
11
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Operating Systems 

 Windows
®
 7 SP1 or higher, Professional and Ultimate (64-bit) 

 Windows
®
 8  (Standard),  Professional and Enterprise (64-bit) 

Software 

 IMAGINE Photogrammetry 2016 
12

 

 One of the following products from Bentley Systems, Inc 
12

 

o MicroStation V8i (SS1- SS3 Update 1) 

o Bentley Map V8i (SS1 - SS3 standalone or for MicroStation) 

o Bentley Map Enterprise V8i (SS1 - SS3)  

 

Recommended Graphics 
Cards 

 NVIDIA
®
 Quadro

®
 K5200, K4200, K2200, K420 

13
 

 NVIDIA Quadro K5000, K4000, K600 
13

  

Recommended Stereo 
Display Monitors 

 120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit 
14

 

Peripherals 

All software installations require: 

 One Windows-compatible mouse with scroll wheel or equivalent input device  

 Printing requires Windows-supported hardcopy devices 
15

  

Software security (Intergraph Licensing 11.11.1) requires one of the following: 

 Ethernet card, or  

 One USB port for hardware key 

Advanced data collection requires one of the following hand controllers:
16

  

 TopoMouse™ or TopoMouse USB™ 

 Immersion 3D Mouse 

 MOUSE-TRAK  

 Stealth 3D (Immersion), S3D-E type, Serial Port 

 Stealth Z, S2-Z model, USB version 

 Stealth V, S3-V type (add as a serial device) 

 3Dconnexion SpaceExplorer mouse   

 EK2000 Hand Wheels 

 EMSEN Hand Wheels 
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 Z/I Mouse 

PRO600 SYSTEM REQUIREMENTS NOTES 
11

 Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity. 
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves 
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk drives are 
subject to network limitations.  

12
 Any further requirements defined by any of the listed apply implicitly to PRO600. 

13
 Graphics cards certified with previous versions of PRO600 may also be compatible, but are not certified in the 

current version. 

14
 Stereo Monitors certified with previous versions of PRO600 may also be compatible, but are not certified in the 

current version. 

15
 HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.  

16
 Stealth S-Mouse (S2-S model) and MOUSE-TRAK are only supported in Stereo Analyst

®
 for ERDAS IMAGINE.  
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ISSUES RESOLVED 

IMAGINE ESSENTIALS 

CR # 
Summary – IMAGINE 
Essentials 

Description / How to Reproduce 

1-BH5A5N 
Buffer doesn't work with this 
Shapefile 

On the Vector tab start the Buffer Analysis dialog. Load the shapefile provided as input. 
Receive error message stating:  Invalid file, check Connection parameters. The dialog does 
accept other shapefiles. 

1-KI9IVO 

ERDAS IMAGINE doesn’t 
read State Plane  US Survey 
Feet CRS from ESRI 
shapefile 

Customer reported that when an ESRI shapefile, having  coordinate reference system in US 
State Plane US Survey feet, is used in ERDAS IMAGINE for creating an AOI, they get an 
error message about incompatible  CRS with raster image, even if both the raster and 
shapefile have the same  coordinate reference system.    

After investigation it was found that even if the shapefile has correct CRS in “US Survey 
feet”, the Vector Metadata doesn’t recognize the CRS of the shapefile. If the CRS State 
Plane is changed to “Feet”, ERDAS IMAGINE recognizes the CRS of the shapefile and 
creates a correct AOI. 

1-7P6FXB 

Zonal Attributes tool does not 
calculate MEAN correctly for 
some polygons 

The Zonal Attributes tool is not calculating the correct MEAN value for some polygons. It 
appears to happen to polygons that are completely within other polygons. The input raster 
image is unsigned 1-bit with pixel values of either 0 or 1. The MEAN value calculated for 
some polygons is 0, but when you inspect the data you can clearly see that there are pixels 
with value of 0 and 1 located within these polygons.  Steps to reproduce the problem.  

1. Open the Zonal Attributes tool (Vector tab > Manage group > Zonal Attributes).  

2. Select Shapefile as the input vector layer.  

3. Select an input raster layer.  

4. Enable the Mean option for the Zonal Functions and name the attribute 
“MEAN_TEST”  

5. Click OK to begin the process.  

6. Open the raster image in a 2D View.  

7. Open the Shapefile in the same 2D View on top of the raster layer.  

8. View the attributes (Table tab > View group > Show Attributes). You will notice that 
some polygons have a MEAN_TEST value of 0.000.  

9. Select the row in the attribute table for one of these polygons to highlight it in the 
2D View.  

10. Observe that there are pixels with value of both 0 and 1 within the polygon. 

1-7T38GB 

Round trip projection is 
incorrect for certain 
projections 

The Jenkins test Statepalone gawest-roundtrip produces outputs but the comparison data 
and the output data do not match. When you look at ImageInfo of both images the map info 
is different for both images. The new data is slightly to the northwest of the original data. 
When you have them in different viewers it is off by 1.67 m north- south and 2.73 M east-
west. 
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1-7V75CJ 
Projection: Reproject 
StatePlaneGAWest 
RoundTrip is not correct 

Projection-Reproject-StatePlaneGAWest-RoundTrip output is different than the input 

1-8H3TEF 

GeoMedia connections take 
too long for the feature table 
to show up in the connection 
manager 

FBDG, sql and oracle take to long for the feature table to appear in the connection manger 
because imagine does something different than GeoMedia does when searching for valid 
tables. 

1-A0O8X1 

ERDAS IMAGINE Hangs on 
autoroaming in 2D View after 
selecting 'Sync GeoMedia 
Map Window to View' 

To replicate: 

1. Install GeoMedia 2014 and ERDAS IMAGINE 2014  

2.  In ERDAS IMAGINE, open the desired data in a 2D View.  

3. In GeoMedia, open a connection to a geographically-similar warehouse as the data 
loaded in ERDAS IMAGINE.  

4. In ERDAS IMAGINE, click Home tab > Link Views > Connect and Link to 
GeoMedia.  

5. Click Home tab > Link Views> Sync GeoMedia Map Window to View  

6. Select Home tab > Pan  

7. Double click in the 2D View of ERDAS IMAGINE  

8. Observe that ERDAS IMAGINE hangs 

1-A5DS91 

Shapefiles created using 
ERDAS IMAGINE native 
support cannot be opened as 
Vector Input  

Create a shapefile either using subset tool or new vector layer. Open the layer for editing. Try 
using it in spatial modeler as new Vector Input- preview and it crashes ERDAS IMAGINE. 
Close the session of ERDAS IMAGINE and resuse the file and it works. I marked this as 
regression since we do have a test case in AT that has this work flow and it passed.  I found 
this issue in IDK 208 on algotron that has GMo 2014 

1-AII3KV 

ERDAS IMAGINE 2014 
created ECW file with 
EPSG:3044 fails to open in 
ERDAS IMAGINE 2014  
v14.00.01 

Customer reported that ERDAS IMAGINE 2014 created ECW file failed to open in ERDAS 
IMAGINE 2014  v14.00.01 and 2015 because we no longer handle the EPSG:3044 
projection correctly.   While opening the customer’s ECW file in ERDAS IMAGINE 2014  
v14.00.01 and 2015, you will see the following error message: “ Layer MapInfoRead fail”.  
ERDAS IMAGINE 2014  v14.00.01 never completes opening the file, but 2015 does open the 
file without projection and gives all the error messages.  ERDAS IMAGINE 2014 can open 
the customer’s ECW file without any error message.   

1-BJ2EHQ 

Displaying specific, large 
shapefiles crashes ERDAS 
IMAGINE 

Start ERDAS IMAGINE and maximise it to your screen. Use the File Chooser to select and 
display gadm2.shp. It may take several minutes for it to finish drawing. Once displayed clear 
the View. Use the File Chooser to select and display WorldBoundaries.shp. Should be much 
faster. Once displayed clear the View. Use the File Chooser to select and display 
gadm2.shp. Part way through drawing the layer ERDAS IMAGINE will crash  If it doesn't 
crash, keep going through the cycle until it does crash. 

1-DUT6Z4 

ECW batch export with 4 or 
more parallel processes in 
the Batch Tool, results in 
some encoding of images 
failing. 

Report that when running 4 or more parallel Export ECW processes of a long list of images in 
the Batch Tool, some encoding of images fail. When the encoding fails for one batch 
process, sometimes the batch process locks up, cannot close out the failed process, and 
does not move to another image. At the end of the batch process it can be noted that more 
processes have failed.  
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1-B8H02Y 

Shift observed in MosaicPro 
with blk file and the shapefile 
in South Dakota State Plane 
projection 

Steps to reproduce:   

1. Load image and shapefile in 2D View and in a third-aprty GIS application. 

2. In the IMAGINE viewer the Shapefile appears shifted 

3. Load the Shapefile file on its own in a 2D View and record the coordinate of the 
vertices  

4. Load the image alone into a 2D View and check the coordinate of the pixel 
corresponding to the shifted location 

5. They seem to be not coincident. 

1-CEZNAG 
ERDAS IMAGINE crashes  
while opening new  SPOT6  
DIMAP v2 xml file in 2D View 

Report that ERDAS IMAGINE 2015 v15.1 crashes while opening new multispectral SPOT6  
DIMAP v2 xml file in 2D View.  Not all SPOT6 images exhibit this behaviour. 

1-CWBAZI 

MosaicPro and ECW 
DirectWrite  are unable to 
write projection from MrSID + 
aux file 

Customer reported that ECWDirectWrite Export tool and MosaicPro both are  NOT writing 
the projection information to the output ECW if the projection of MrSID file is in the aux file.  
Tested with customer's data where the projection information, EPSG:2868  is stored in the 
aux file, not in the MrSID tag.   

1-1HU8-
36900 

Last line and last column (last 
row and last sample) are lost 
when exporting small IMG 
format image to JFIF (JPEG) 
or TIFF 

Problem encountered in ERDAS IMAGINE 2015 v15.1. The input image is 512 by 512 pixels, 
but the exported data is only 511 x 511 

1-62QHXJ 

Cannot reshape AOI when 
zoomed 

The editing of an AOI when you zoom in using the mouse wheel is difficult and sometimes 
impossible. Problem is most repeatable when you set the line width thicker and use line 
colors. The customer is getting a failure to move the vertex in Reshape mode.    To replicate: 

1. Load image in viewer.   

2. Select Drawing tab and draw polygon aoi (creating new aoi).   

3. Select aoi and Reshape tool.   

4. Vertices are highlighted.   

5. Zoom in on one vertex.  That vertex cannot be moved.   

6. In zoomed view, aoi is locked and cannot be deselected, and reshape tool cannot 
be exited.  One must go back to full-res view to do either. 

1-83017K 

Changing style for a class in 
Feature Counter Tool 
crashes ERDAS IMAGINE 

ERDAS IMAGINE consistently crashes if you try to change the ‘Menu’ Style Feature Counter 
Tool Class editor to other.  Steps to reproduce:  

1. Open any raster dataset  

2. Go to File / New / 2D View / Count Features  

3. Right-mouse-click on any of the classes. Select ‘Edit Category…’  
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4. The Edit Category window pops up. In the lower right you can select the symbol  

5. Click on the arrow down button, and the list of symbols from the Menu Class 
shows up. You can select any of these symbols  

6. In the same list, now click on ‘Other’ to select a different style.  

7. ERDAS IMAGINE will exit. 

1-8EP7XT 
Add ability for ERDAS 
IMAGINE to direct-write to 
ERS BIL format 

Customers wish to supply raster datasets in .ers format. They specifically require a BIL + 
Header format. 

1-8LRTKV 

Always Wait for Data Viewer 
Preference Doesn't Work 

1. In your preferences (Viewing, Viewer) set "Always wait for data" to true (checked).   

2. Save and restart IMAGINE.   

3. Load a large image (preferably something compressed) and start roaming around.   

4. With the preference set you should never be able to see an empty block, the 
viewer should lock up waiting to render the block.  But since ERDAS IMAGINE 
2013 was released it seems it's back to showing empty blocks. 

1-8N6PHR 

ECW v3 Direct Write has 
major compression artifacts 
from some applications 

1. Set ECW preference to v3.   

2. Run Subset (using either map or file coordinates) on a calibrated input image, to 
ECW output. 

3. Output file has major compression artefacts.  Did not see problem when running 
Export ECW or Import NITF to ECW. 

1-8ZC99D 

With Map View opened, NITF 
Metadata Viewer will be not 
responding 

1. Start IMAGINE;  

2. Add a new Map Viewer;  

3. Go to Manage Data tab, NITF > View NITF Metadata.  

4. The NITF Metadata Viewer is not responding. 

1-91BCTT 

Unsupervised classification 
on an ndvi image created 
from 16 bit imagery crashes 

1. Open a 16-bit multi-spectral image 

2. Create an NDVI image from it.  

3. From the NDVI, try to run an unsupervised classification.   

4. The process doesn't complete, it crashes  

This seems to work starting off with 8-bit imagery and performing the same process, but not 
with 16-bit imagery. 

1-93Z7UX 

Measurement Tool reports 
conflicting height 
measurement with Top 
Shadow Measurement 

Measurement height utility reports unexpected height values using Top Shadow Height with 
customer GeoEye data. Height measurements with other two options (Height from Layover, 
Base Shadow Height) return comparable measurement values for the same location. Height 
from Layover 9.29 m Base Shadow Height 9.37 m Top Shadow Height 5.58 m.  Testing 
indicates a dependency on the data being measured. Similar tests with in-house WV1 data 
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show comparable measurement values using all methods. 

1-9BZEIZ 

Photoshop is unable to open 
the file if ERDAS IMAGINE 
2014 v14.1  writes projection 
to a GeoTIFF file 

Customer reported that Photoshop is unable to open the file if ERDAS IMAGINE 2014 v14.1  
writes projection to a GeoTIFF file, if that GeoTIFF was an output from Photoshop. 
Photoshop gives the error message: “Could not complete your request because it was not 
the right kind of document”.  Please note, the TIFF file that Photoshop cannot read can be 
read in ERDAS IMAGINE, ER Mapper, ArcGIS 10.1, Microsoft Products. This is a problem 
with Photoshop.  

1-9XZA4F 

Export NITF 2.1/NSIF 1.0 
does not accept some TRE 
metadata values 

Export NITF2.1/NSIS 1.0 will not accept TRE ACCPOB values. After entering metadata 
value, error "Transform not found!" opens, after dismissing error message, Export NITF 
dialog closes.  The error is seen in the TRE ACCPOB but not in other extensions (e.g. 
ACCHZB). 

1-A9U68D 
EPSG.plb has incomplete 
entries for CRS that were 
converted from GK to TM 

Some of the changes made to epsg.plb in ERDAS IMAGINE 2015 to output Gauss Kruger as 
Transverse Mercator were missing Scale Factor.  This could cause issues in the projection 
chooser, especially if trying to find CRS based on EPSG code. 

1-ABABZ8 

Customer reported that 
PointcloudInfo  crashes while 
trying to add EPSG 5514 to 
their LAS file. 

Pointcloudmetadata  and the “Point Cloud Commands tool” crashes while trying to add 
EPSG 5514 to LAS file.  The following error message occurs before the crash happens: 
“Invalid INICODE Map Projection Structure” This projection doesn’t comply with the EPSG 
Standard. Select Another projection that is EPSG compatible”. 

1-AC7V3Z 
Spatial Modeler can't handle 
TIFF data with "#" in the path 

A TIFF file whose path includes a “#” character can be opened in a 2D View. But opening it in 
Image Chain, or using it in other Spatial Models, will crash ERDAS IMAGINE. 

1-AGYBK0 

For multi-layer WMS servers 
ERDAS IMAGINE does not 
turn on the correct "level" and 
so nothing is displayed 

ERDAS IMAGINE 2015 added new WMS support which includes support for having multiple 
layers in the service.   When there are multiple layers ERDAS IMAGINE turns on by default 
only the layer that has the largest spatial extent. To do so it has to look at all the layers, 
reproject to a common map projection and compare the extents.  Unfortunately, for the 
National Map NLCD web mapping service, which contains layers cascaded into multiple sub-
trees, ERDAS IMAGINE selects and turns on a "directory" name, but not all the layers 
contained in that directory and so nothing displays by default.  WMS used for testing: 
http://raster.nationalmap.gov/arcgis/services/LandCover/USGS_EROS_LandCover_NLCD/M
apServer/WMSServer?request=GetCapabilities&service=WMS 

1-ARBYGC 

$HOME and $PERSONAL 
not defined in Help 

$HOME and $PERSONAL variables are used by ERDAS IMAGINE to deposit log files and 
some other artifacts (default layout, elevation library, proxies, file and session histories, 
V8preferences, etc.).    Issues arise if the user’s homespaces are on a server that is 
unreliable, read-only, non-existent, etc.  The ERDAS IMAGINE artifacts can't be correctly 
created and the software experiences difficulties.  The customer then requests a way to have 
all of these things going somewhere else.  There are preferences for some of these items, 
but not all of them. So where are they set?    

 If not set in the environment, ERDAS IMAGINE creates its own local value for 
HOME by concatenating HOMEDRIVE and HOMEPATH  

 If not set in the environment, ERDAS IMAGINE constructs PERSONAL, by 
concatenating .imagineNNNN to the HOME environment variable, where NNNN 
reflects the version number of IMAGINE.     

It is rare for a Windows machine to not have something for HOMEDRIVE and HOMEPATH. 
But there are many cases where customers had poorly-chosen values for HOMEDRIVE and 
HOMEPATH.  The most common is a read-only location, a root drive (e.g. C: or H:), or an 
unreliable network location.  Complaints arise when the customer is unable to override the 
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settings pushed down via group policy from their network administrators.  In general 
administration of Microsoft Windows, the Network Administrator is supposed to decide where 
user-specific settings should be stored, and ERDAS IMAGINE is respecting that decision.    
The most effective workaround is to set a good value for HOME on the machine.  It is rare for 
that variable to be restricted. 

1-ATLT63 
IMAGINE File menu a lot 
slower now due to the Recent 
Thumbnails 

Open multiple datasets in imagine, after a while when selecting the File Menu, the screen 
freezes up for several seconds. Looks like the thumbnails from the recent documents tab is 
taking too long to load 

1-AUNY8Y 

Height from Layover and Up 
is Up not working on DG 
WorldView-2 imagery 

Specific NITF image does not appear to behave correctly when using Up is Up or measuring 
Height from Layover in a 2D View.  To replicate:   

1. Open the image into a 2D View.  

2. Roam to a location with a tall feature  

3. Home tab / View group / Align to up is up  

4. The feature is not rotated to point up the screen 

1-AUP231 

Compression is incorrect for 
Sub-Image of NITF file in 
Metadata>General tab from 
read only folder 

Open a Sub-Image of NITF file in metadata. Observe that general tab > Layer info > 
compression value reported is incorrect, compared with NITF Info tab > Image (related to 
particular sub-image) in tree, Field: IC; LongName: Image compression. 

1-AYNGWH 

ERDAS IMAGINE states 
unsupported compression 
type for Tiff file created in 
ArcGIS with LZW 
compression 

When opening a specific TIFF file with LZW compression created in a third-party application, 
into a 2D View, ERDAS IMAGINE throws error that, 'Unsupported compression type' but 
displays the file in viewer.   

1-B12DIG 

Can't Chip a TIFF file To replicate: 

1. Display a BGRN TIFF in a View.  

2. On the Raster tab, Subset & Chip menu, select NITF Chip.  

3. Provide an output NITF file name.  

4. You will be asked to save all layers - click Yes.  

5. Receive error message along the lines of  "Error opening file  
d:\temp\po_391401_bgrn_0000001__GeoEye__0_MULTI.sbi Error 123"  ...and 
you can't proceed. 

1-B12MDI 
IMAGINE Metadata window 
is displaying wrong file size 
for large LAS 1.2 file 

Customer reported that ERDAS IMAGINE’s Metadata window is displaying the wrong file 
size for a large LAS 1.2 file. The customer is using a 59 GB LAS 1.2 file. The metadata  
window shows the file size as  606 MB only. 

1-B2DVMZ 

NAD_1983_StatePlane_Loui
siana_South_FIPS_1702  
Standard Parallel parameters 
different from EPSG definition 

ERDAS IMAGINE uses Standard Parallel projection parameters that are reversed from 
EPSG parameters.   

1. This will result in defining the projection incorrectly when adding it with ERDAS IMAGINE. 
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 2. This will result in not recognizing the State Plane CRS when the Standard Parallel 
projection parameters are defined correctly in a shapefile prj file generated by GeoMedia.  

1-B2YLK6 

Batch Export NSIF/NITF does 
not retain TRE values 

Export NITF/NSIF using batch will not retain user defined TRE (Tagged Record Extension) 
values, even when batching one file in and one file out.   These same TRE values are 
retained when exporting interactively without using batch, but are lost when running in batch. 
To replicate: 

1. Export NSIF 1.0 from an Imagery Input File  

2. Segment = MAIN_HEADER  

3. Section = Extended Data  

4. TRE: = "GEOPSB"  (use default values)  

5. TRE: = "PRJPSB"  

6. Select PRJPSB, Edit the "NUM_PRJ" field to 3.  

7. Set the 3 PRJ fields to, respectively, "31", "0.996" and "0".  

8. Edit the XOR field to "500000".   

9. Select 'Batch' Select 'Run Now'  

10. Using the exported .nsf as input, open Metadata > NITF Info tab PRJPSB does not 
contain any of the modified values. Other default fields are missing.   

Compare using the same procedure above but using OK instead of Batch. All of the 
modified TRE values are retained. 

1-B71Q8F 

Rapid Atmospheric 
Correction bubble help refers 
to Image Calibrator 
Environmental Correction. 

When you hover the mouse cursor over the Batch button in the Rapid Atmospheric 
Correction tool the bubble help and status bar refer to Image Calibrator Environmental 
Correction. It incorrectly says “Put the Image Calibrator Environmental Correction in the 
Batch Queue”.  

1-B726WI 

ERDAS IMAGINE 2015 ECW 
reprojection from Israel 
projection EPSG:2039 to  
EPSG:4326 fails 

ERDAS IMAGINE 2015:  ECW reprojection from Israel projection EPSG:2039 to WGS84/ 
Geographic EPSG:4326  fails.  ERDAS IMAGINE gives error message:  “Unable to update 
Map Information to ECW file. The Update will be saved in the aux file. 

1-B9UJ5Q 

ERDAS IMAGINE 2015 
crashes while adding ECWP 
layer from APOLLO 
Essentials 

Customer reported that ERDAS IMAGINE 2015 crashes while adding ECWP layer from 
APOLLO Essentials.  The same ECWP URL works well in Internet Explorer 11 and Firefox 
with ECW Browser Plugin. 

1-BAF41Z 

Add support for Deflate 
compression in TIFF 
DirectRead and Import TIFF 

Customer request support for Deflate compression option added to TIFF 6 in Supplement 2. 
Support is requested in DirectRead and Import TIFF.  Deflate is a combination of LZ77 and 
Huffman encoding. It is similar to LZW. The Deflate compression is used in PNG, zip, gzip 
and other areas. 

1-BAXNDB 

Difference in behaviour in 
ERDAS IMAGINE 2014 and 
2015 - Crash observed on 

To replicate: 

1. Open a specific Shapefile in 2D Viewer.  
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dismissing error messages 2. Dismiss all the error dialogs  

3. Click in 2D View  

4. Observe that ERDAS IMAGINE 2015 crashes  

1-BETNMA 

Compute pyramid layers 
message displays when 
IMG/IGE file WITH pyramid 
layers is opened in 2D View 

When opening a large IMG/IGE file WITH pyramid layers in a 2D View an attention message 
pops up claiming that the image does not have pyramid layers. If you open the same image 
in ERDAS IMAGINE 2014 it displays without any problems.  The Viewer preference 
“Compute pyramid layers upon image open (if needed)” is set to “query” for both ERDAS 
IMAGINE 2014 and 2015.  

1-BEWINN 

License Expiration 
Information dialog states 
'[null]' 

When a temporary license of ERDAS IMAGINE is close to its expiration date, License 
Expiration Information dialog pops-up, which states 'License for [null] will expire in 7 days.'. 
Here it is not clear what [null] stands for. It would be good if [null] is replaced by component 
name for which the expiration date is specified. 

1-BFC5UO 

NDVI is not honouring the  
boundary of AOI, even if the 
“Subset using bounding box 
of AOI” is uncheck 

Customer reported that NDVI is not honouring the boundary of AOI, even if the “Subset using 
bounding box of AOI” is unchecked in the Preference.  Customer is trying to use an AOI to 
constrain an NDVI calculation. After adding the input file, naming the output file and adding 
the AOI in the NDVI dialog, once the NDVI process in run, the output file's extent shows as 
large as the input file and not constrained by the AOI outline (as selected in preferences).  

1-BFLR8V 

NDVI dialog is not honouring 
AOI from the viewer, giving 
error message that AOI not 
found. 

Customer reported that NDVI dialog is not honouring AOI from the viewer, giving error 
message:  “File C:/Users/xxxx/AppData/Local/Temp/2/Aoi005032(:Aoi) does not exist.  In 
order to recreate the problem, please do the following:  

1. Open Image in viewer.  

2. Create AOI 

3. Save AOI to file 

4. Open NDVI dialog  

5. At this point the above error pops up.  However you can see that the AOI is in fact 
there in the directory.  

6. Click OK and select input and output files.  

7. Select the option AOI from viewer and run process.  

8. The process doesn’t complete and gives error message:  “Spatial Model Failed in 
Raster Input . Error:  eaoi::AOI::Impl::LoadHandle failed 
eaoi_ReadAoiFromNamedHfaFile failed eaoi_ReadAoiFromHfaFile failed The 
specified AOI is empty” 

1-BFLRFE 

NDVI dialog is not loading 
raster automatically from the 
Viewer if AOI is present in the 
viewer 

Customer reported that NDVI dialog is not loading raster automatically from the Viewer if an 
AOI is present in the viewer.  If there is no AOI in the viewer, then the NDVI dialog loads the 
raster in the viewer automatically as an input file. 

1-BGSM9P 

Print to HTML from 2D View 
does not work. 

If you attempt to print an image from a 2D View and output to HTML it will not work. An 
HTML file is created, but it does not contain the contents of the 2D View, it is essentially 
empty. The print to HTML process does not create the JPEG image that is to be included in 
the HTML file. After you click OK in the Print dialog you will get two error messages. The first 
one says “Invalid arguments for option setdpu”, and the second one says 



 

Issues Resolved 

 

May 26, 2016 71 

“FileProxiedIdentifyAndOpen failed (2:The specified file does not appear to exist) for 
d:/print_test.img”.  

1-BI1SY9 

If “Save File History” is 
checked  in the  Preference, 
IMAGINE crashes  while 
doing Layerstack / subset 

Customer reported that if the “Save File History” is checked  in the  Preference (Preference > 
File format > Image Files (General) > Save File History), ERDAS IMAGINE crashes while 
performing  “Layer Stack”, or “Decorrelation Stretch” or doing “ Subset” with any data. 

1-BNTEUK 

IMAGINE Standard Layout 
File pulling IMAGINE 
Advantage level license 

Customer has several IMAGINE Essential level licenses and only 2 IMAGINE Professional 
level licenses. They are constantly running into licensing issues where users are pulling 
IMAGINE Advantage level license (from their 2  IMAGINE Professional licenses) when they 
shouldn't be.  This occurs when selecting File | Layout | Standard Layout. When selecting 
this option the Zonal Change Layout flashes open before changing to standard layout and 
appears to consume the  IMAGINE Advantage license. 

1-BNYQTD 

Help - Customer support icon 
is not functional in Help page 

To replicate: 

1. Launch ERDAS IMAGINE   

2. Launch Help from Help>Help from IMAGINE  

3. Click on the customer support icon which is on the top right corner in the page  

4. No action was seen on clicking the Customer support icon 

1-BS8NND 
Confusion caused by multiple 
projection name entries in 
Projection Chooser 

This has been reported by multiple customers. Old “Deprecated” projections were still being 
displayed and causing the confusion. 

1-BY8JZJ 

Customers have asked for 
ECW v3 to fully use GeoTIFF 
tags 

Customers have asked for ECW v3 to fully use GeoTIFF tags, not be limited to EPSG codes. 
Many counties in the US are developing their own projections so that they can improve the 
accuracy of their data within their area of responsibility.  These new Projected Coordinate 
Systems are not defined in EPSG, but can be defined by GeoTIFF tags. 

1-CVV2RW 

Direct Save As method 
creates unusual pixels in 
16bit output 

1. Open a specific multispectral 16bit IMG image.  

2. Right-Click in contents panel > Save As and also File > Save Top Layer As  

3. The output image in both cases has very strange visual pixel artefacts that 
essentially leaves the output image unusable unless you select a new stretch and 
apply it. 

1-D3ZI07 

Five EPSG projections in 
Pulkovo 1942(58)  datum 
having two different 
definitions for the same 
EPSGs 

Customer reported that in the ERDAS APOLLO Essentials they could not serve imagery in 
EPSG:3333 and EPSG:3334 CRS. Then customer himself found that there are two 
definitions for each of these CRSs in epsg.plb. Since ERDAS APOLLO Essentials uses 
ERDAS IMAGINE’s projection engine, I have also checked in ERDAS IMAGINE 2015 v15.1. 
and found that there are five projections in Pulkovo 1942(58)  datum which have  two 
different definitions for the same EPSG code.  The EPSG codes are: 3333,  3334, 3335,  
3336, 3337  Following  are  the definitions in the epsg.plb file: } "Pulkovo 1942(58) / Gauss-
Kruger zone 3 (3333)" {  INTERNAL 9 "Krasovsky" "Pulkovo 1942(58) [To WGS 84 19]" 0   
4:2.6179938779914941E-001  5:0.0000000000000000E+000   
6:3.5000000000000000E+006  7:0.0000000000000000E+000 "meters" } "~Pulkovo 1942(58) 
/ Gauss-Kruger zone 3 (3333)" {  INTERNAL 36 "Krasovsky" "Pulkovo 1942 Adj 1958" 0   
4:2.6179938779914941E-001  5:0.0000000000000000E+000   
6:3.5000000000000000E+006  7:0.0000000000000000E+000 "meters" } "Pulkovo 1942(58) / 
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Gauss-Kruger zone 4 (3334)" {  INTERNAL 9 "Krasovsky" "Pulkovo 1942(58) [To WGS 84 
19]" 0   2:1.0000000000000000E+000  4:3.6651914291880922E-001   
5:0.0000000000000000E+000  6:4.5000000000000000E+006   
7:0.0000000000000000E+000 "meters" } "~Pulkovo 1942(58) / Gauss-Kruger zone 4 (3334)" 
{  INTERNAL 36 "Krasovsky" "Pulkovo 1942 Adj 1958" 0   4:3.6651914291880922E-001  
5:0.0000000000000000E+000   6:4.5000000000000000E+006  
7:0.0000000000000000E+000 "meters" } "Pulkovo 1942(58) / Gauss-Kruger zone 5 (3335)" {  
INTERNAL 9 "Krasovsky" "Pulkovo 1942(58) [To WGS 84 19]" 0   
2:1.0000000000000000E+000  4:4.7123889803846897E-001   
5:0.0000000000000000E+000  6:5.5000000000000000E+006   
7:0.0000000000000000E+000 "meters" } "~Pulkovo 1942(58) / Gauss-Kruger zone 5 (3335)" 
{  INTERNAL 36 "Krasovsky" "Pulkovo 1942 Adj 1958" 0   4:4.7123889803846897E-001  
5:0.0000000000000000E+000   6:5.5000000000000000E+006  7:0.0000000000000000 

1-DF9GML 

ERDAS IMAGINE crashes 
While clicking on Draw line 
left to right button on 
Transform dialog from 
Algorithm 

1. Launch ERDAS IMAGINE  

2. Select Algorithm from File > New  

3. Click on Algorithm tab  

4. Select Transform from Layer group, Transform dialog opens.  

5. Click on Draw line left to right or Draw line right to left from Histogram Edit Tools observe 
ERDAS IMAGINE crashes 

1-DF9U9O 

ERDAS IMAGINE Crashes 
on resizing In-View Magnifier 

To replicate: 

1. Launch ERDAS IMAGINE, 

2. Load any Raster image in the 2D View 

3. Click on In-View Magnifier button from Home tab | View Group 

4. Resize the Magnifier in the 2D View  

5. ERDAS IMAGINE Crashes 

1-DK9FHH 

“Bad allocation” error pops up 
if stretch panel is launched 
with Spatial Model panels 
hidden & clicked in 2D View. 

Please follow these steps to reproduce 

1. Launch ERDAS IMAGINE and open Spatial Model Editor 

2. Click on the Auto Hide options for both Operators and Properties panels 

3. In the 2D View open a raster as image chain 

4. Once the image is displayed, click on the Stretch Panel option.   

5. Notice that Stretch Panel does launch, but is hidden to the right of ERDAS 
IMAGINE 

6. Click anywhere on ERDAS IMAGINE 

7. Notice that "bad allocation" error shows up 

1-DK9FJ1 

ERDAS IMAGINE crashes if 
3D View with a DEM 
displayed in it is switched off 

Please follow these steps to reproduce this issue 

1. Launch ERDAS IMAGINE and create a new 3D View 
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2. Open a DEM in the 3D View 

3. From the Contents panel click on the check box of the 3D View to turn off the 
display of the 3D View.   

4. Notice that ERDAS IMAGINE crashes 

1-EXBIFY 

Paragraph format correction 
needed to 'importascii' 
command line OLH 

'importascii' command line OLH documentation needs indentation of "ignorezero" argument 
for clarity.  OLH document is accessed through Appendices > Application Commands > 
Alphabetical Index > importascii   

'ignorezero' argument should be indented to left for consistency with other command 
arguments  

1-F2EJZ5 

ERDAS IMAGINE 2015 v15.1 
crashes while opening some 
ECWP streams from ERDAS 
APOLLO 

Customer reported that ERDAS IMAGINE 2015 v15.1 crashes while opening ECWP URLs 
from ERDAS APOLLO 2015 v15.1. The same ECWP URLs can be successfully opened in 
ER Viewer and ArcGIS Plug-in. 

1-G27I1H 

ERDAS IMAGINE is crashing 
after removing .ixw file from 
Default Layout in 
preferences. 

To replicate: 

1. Launch ERDAS IMAGINE 

2. Navigate to File > Preferences > User Interface > Ribbon Interface  

3. Remove the .ixw file from Default Layout - Make it empty 

4. Click 'Save' button.  

5. Make sure there is nothing in Default Layout.  

6. Exit ERDAS IMAGINE 

7. Launch ERDAS IMAGINE  

8. Observed that ERDAS IMAGINE is crashing while opening and unable to launch 

1-JJKGAS 

Opening IMG files with long 
path names crashes ERDAS 
IMAGINE 

Opening IMG files with very large path name crashes ERDAS IMAGINE.  For example, the 
following path causes a problem: 

\\alpha\ARRAY4\DataLibrary\Sentinel-
2\S2A_OPER_PRD_MSIL1C_PDMC_20150820T085706_R051_V20150815T110427_2015
0815T110427\GRANULE\S2A_OPER_MSI_L1C_TL_MTI__20150819T171650_A000763_T
30SVD_N01.03\IMG_DATA 

1-JJKGHG 
Error messages coming from 
rf_srp when opening JP2 
images with long path names 

The error messages are actually coming from rf_srp. This is a side-effect of the fact that the 
JP2 RasterFormat DLL wasn’t able to open the file, so it got passed to the SRP 
RasterFormat DLL to see if it could open it. 

1-JKIS2B 

Projection/map model info 
doesn't stick JPEG2000 

Unable to set the projection or map model and projection info for JPEG 2000 file. ERDAS 
IMAGINE clears entered info once you close the metadata window. Problematic JP2 is a 
NAIP CIR image downloaded from the USGS's Earth Explorer 
(http://earthexplorer.usgs.gov/). 
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1-JPEJIW 
JP2 format  zooming and 
panning slowness  in ERDAS 
IMAGINE 2D View 

Customer reported that ERDAS IMAGINE 2015 v15.1 takes longer time refreshing JPEG 
2000 images in the 2D View than a third parties v10.3 Viewer. The customer is using JPEG 
2000 file created in ERDAS IMAGINE 2015 v15.1 

1-JUE54T 

ERDAS IMAGINE crashes on 
changing format to GIF under 
WMS tab  of  Hexagon 
Content/Imagery  BaseMap 

To replicate: 

1. Launch ERDAS IMAGINE   

2. Select Home > BaseMap > Hexagon Content  

3. Enter user name and password  

4. Add the connection and click OK button  

5. Select WMS tab  

6. Change Format to Image/gif  

7. Observe that ERDAS IMAGINE crashes 

1-JW0ATU 

(incorrect) NITF 2.1 files 
created by Kakadu software 
and Gdal Library display 
badly in ERDAS IMAGINE 
2015 v15.1 

Customer reported that NITF 2.1 files created by Kakadu software and Gdal Library display 
poorly in ERDAS IMAGINE.  However the same NITF2.1 file displays correctly in third-party 
GIS application.  

This issue was caused by the ABPP being incorrectly defined in the NITF header. 

1-JZY219 

IMAGINE populate errors 
when opening NTF with 
RPC00B, and 
RPC00A+RPC00B 

NITF images containing both RPC00A and RPC00B generating error messages. 

1-KJLT9M 
pixeltotable function causes 
errors when run from ERDAS 
IMAGINE command line 

When you run the pixeltotable function from the ERDAS IMAGINE Command Window using 
the “-criteriatype” and “-criteriafile” options it causes a lot of pop-up error messages. 

IMAGINE ADVANTAGE 
IMAGINE 
Advantag
e CR # 

Summary – IMAGINE 
Advantage  

Description / How to Reproduce 

1-9B6E6B  

F1 OLH points to MosaicPro 
Page for Image Area Options 
and File Name Matching tabs. 

1. Launch Mosaic Pro  

2. Select Edit Menu > Add Images  

3. Select 'Image Area Options'  tab  

4. Press F1 and observe that Help points to MosaicPro   

5. Select Individual AOI  Radio button under Image Area Options tab  

6. Select Single Aggregate Shapefile  

7. Click Set Button   



 

Issues Resolved 

 

May 26, 2016 75 

8. Select File Name  

9. Matching tab Press F1   

10. Observe that F1 points to MosaicPro Help page 

1-C23GQA 

"Adjust individual image 
radiometry" crashes MosaicPro 
if a Thematic image is used 

Enhancement request for disabling the "Adjust individual image radiometry" button, if 
Thematic images are used as input.  Customer reported that MosaicPro crashes when they 
used Thematic images as input and tried to use the Contrast / Brightness control  tool.  
Since the fact that Contrast / Brightness control   cannot be performed with thematic images, 
the customer suggested to disable the "Adjust individual image radiometry" button in the tool 
row (or the control itself) for Thematic images. 

1-AXAW83 

Mosaic Express crashes while 
creating  output from blk file 
created in IMAGINE 
Photogrammetry 

Customer reported that blk file created in IMAGINE Photogrammetry doesn’t work in  Mosaic 
Express.  

1. The customer had created blk files from GeoEye RPC , Rapid Eye RPC….. .  

2. Then they opened the blk file in Mosaic Express, and leaving default options and 
clicking on the 'Finish' button to run the mosaic.  

3. Mosaic Express crashes by giving the error message: ''You need to have 
IMAGINE Photogrammetry installed to use this functionality"   

1-K0TPEX 

NDVI fails with calibrated input 
and Map-based Subset 
Definition 

Replicated using a geometrically calibrated NITF image. To replicate: 

1. On the Raster tab / Unsupervised pull down, select NDVI.  

2. Start an Inquire Box in the 2D View and leave it as Map coordinates.  

3. Move the box somewhere you will recognise. 

4. In the NDVI dialog specify the Sensor as QuickBird-2.  

5. Go to the I/O Options tab and click the From Inquire Box button (which populates 
the dialog as expected).  

6. Click OK to run the NDVI.  

7. Progress meter comes up but goes red almost immediately.   

8. If you do the same, but change to File coordinates the process succeeds. 

1-EMTYI1 

Terrain Prep Tool: merge, 
Points+Breaklines > Output to 
LTFX or IMG does not work; 
only LAS output is OK. 

The dtmmerge within Terrain Prep Tool fails always using a specific Terramodel TIN (.pro). 
TIN contains points and breaklines. dtmmergeprocess.exe exited with status -1073741819 

1-1II8-
40800 

Batch Processing of 
"Orthorectify without GCP" Tool 
Failed 

Customer trying to batch process "orthorectify without GCP". When the batch file is run, 
each process returns an error, "no input file and no output file". 

1-9CFE3X 
OLH for MosaicPro Color 
Corrections dialog points to the 
Welcome page. 

From MosiacPro launch the Color Corrections dialog and click on the Help button. Notice 
that the welcome page is shown instead of the Color Corrections dialog help. 
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1-9O36PH 

Adding a blockfile with one 
image offline will fail to load rest 
online images in MosaicPro 

This issue did not exist in ERDAS IMAGINE 2013 v13.0.2 and is seen only from 2014. 
Please follow these steps to reproduce...   

1. Launch MosiacPro.  

2. Select a blockfile such that it has at least one image online and at least one offline. 
Open this blockfile in MosaicPro.  

3. Use the default options for Elevation Source and Image Area Options.  

4. While adding the images, a Locate File dialog shows up asking for replacing the 
offline image.  

5. Click on the Skip button.   

6. Notice that an error shows up – when dismissed no images are shown in the cell 
array of MosiacPro.    

The behavior in ERDAS IMAGINE 2013 v13.0.2  was, when we Skip the offline images, it 
would honour the selection and add the remaining online images into MosaicPro. But seems 
like from 2014 we are leaving a blockfile with offline images unusable within MosaicPro 
unless and until a user either removes the offline image from the blockfile or makes it online. 

1-9V4DDB 

MosaicExpress is not creating 
output if user uses a blk file in 
the project file 

Regression from ERDAS IMAGINE 2013 v13.0.2.  Customer reported that while running 
MosaicExpress, with block files, it kicks back an error message saying that they need 
IMAGINE Photogrammetry. The customer said that they were running a fully licensed 
version of IMAGINE Photogrammetry in their system. 

1-AQFGGN 

Surfacing tool under Terrain 
Tab Not showing ERDAS 
IMAGINE Version 

Steps to be followed:  

1. Launch ERDAS IMAGINE   

2. Go to Terrain tab  

3. Select surfacing Tool Under terrain Preparation tool.  

4. Click on Show Version in the Help Tab on 3D surfacing Dialog  Box  

5. Observe Blank Dialog Box is Found. This is latent from ERDAS IMAGINE 14.0000 

1-AS1SN9 

ECW v3 16-bit MosaicPro 
output unusable due to bad 
over compression 

Original Summary: Improve ECW v3 16-bit output quality using stat information.  ECW v3 
requires the application to define if the output ECW to be created is 8bit or 16bit. When the 
output ECW is 16bit, the application must send the min and max values of the input 
image(s). This is the min and max of every band of the input data This allows the ECW SDK 
to scale the compression to the data range for the highest quality output file. MosaicPro does 
not feed the min and max values into the ECW v3 encoding. 

1-ASCO4X 

MosaicPro fails intermittently 
when generating large ECW 
files  

Using MosaicPro on Window 8.1, MosaicPro does not create ECW v3 files in some cases. 
Most frequently found a failure in MosaicPro with the following circumstances:    

1. Set ECW Preference to ECW v3 Default  

2. Load 306 images   

3. Do not save MOP   

4. Select ECW as output   
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5. Do not enter an ignore value   

6. Launch mosaic process    

Also found this occurs when you enter a 1 or 255 in the ignore value fields. 

1-B4M3UX 

Mosaicking large number of 
ECW v2 images in MosaicPro 
creates empty IMG output file 

Mosaicking large number of ECW v2 images in MosaicPro sometimes creates empty IMG 
output file   Customer reported that MosaicPro 2015 is creating a completely black image in 
the output when mosaicking a large number of ECW v2 images. The input files are 6000 
ECW v2 images, 18 GB compressed (326 GB uncompressed) and the output file created is 
334 IMG file.    Mosaicing a smaller number of ECWv2 files works correctly. 

1-B72E2P 

Help > Search Commands for 
“Recode” does not return a 
result for Recode tool found 
under Raster tab. 

When you use the Search Commands function under the Help tab and search for “Recode” it 
does not return a result for the Recode tool found under Raster tab (Raster tab > Raster GIS 
group > Thematic menu > Recode). Instead, it returns two results, one for Fuzzy Recode 
(Raster tab > Classification group > Unsupervised menu > Fuzzy Recode), and one for 
Recode (Thematic tab > Edit group). 

1-BC0WRT 

Help Content missing for 
streamed mode from Point 
cloud tab> 3DView> Point 
Mode and 3D Measure group 

To replicate: 

1. Launch ERDAS IMAGINE 

2. Load any LiDAR Data (.Las File i.e Point cloud data)  

3. Select the Point Cloud tab  

4. Now select Show 3D from 3D View group 

5. Now Point Mode is Highlighted, 3D Measure Group also Highlighted 

6. Now Press F1 on Point cloud Tab  

Observe that in Help page with name Point cloud >3D view> Point Mode> Streamed Mode,  
description missing and there is no description about 3D Measure group 

1-BGUS47 
Files of type for blockfile should 
be changed to "Block file" 
instead of "LPS Block file". 

Since the removal of "LPS" term from 14.0 release, all over ERDAS IMAGINE we have 
changed the files of type name for a blockfile from "LPS Block File" to "Block File". But 
seems like we missed to change in MosaicPro as it still says "LPS Block File". 

1-BWPFKX 

TerraSAR-X data is not 
displaying the images in Zonal 
Change once the data is 
processed 

1. Open a new zonal change project and name it test.zcp  

2. In the before image 
add:\\alpha\Teamspace\Pixel\Projects\ZonalChange\Defense\Datasets\Radar\dims_op_oc_
dfd2_204280199_1\TSX-
1.SAR.L1B\TSX1_SAR__SSC______HS_S_SRA_20090924T232619_20090924T232620\T
SX1_SAR__SSC______HS_S_SRA_20090924T232619_20090924T232620.xml and the 
after 
image\\alpha\Teamspace\Pixel\Projects\ZonalChange\Defense\Datasets\Radar\dims_op_oc
_dfd2_204280231_1\TSX- 

1-C5Z7E3 
FLS Segmentation has merging 
errors with segments that 
border NoData 

Problem identied when looking at lakes in a segmented image. The merging is suppressed 
near the shoreline (adjacent to NoData). 
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1-C5ZH0C 
FLS Segmentation does not 
observe Minimum Segment 
Size caused by NoData 

Segment parameter for minimum Size = 10 but NoData in the input has pixels surrounded by 
NoData with no neighbors to merge with. 

1-CEZNDQ 

IMAGINE Orthorectification 
process doesn’t complete  with 
RPC with new SPOT6  DIMAP2 
xml file 

Customer reported that with ERDAS IMAGINE 2015  and v15.1, the Orthorectification 
process doesn’t complete with new multispectral SPOT6  DIMAP2 xml file. The Process List 
eventually shows red in the progress meter. 

1-CTKP4V 

Doc error in Zonal Change 
under Run the Change 
Detection Process 

On the following page, make the following change: 
http://doc.hexagongeospatial.com/ERDAS%20IMAGINE/ERDAS_IMAGINE_Help/#ZonalCh
angeWorkflow.htm  under the title Run the Change Detection Process Change the review 
tab to the process tab 

1-CUFK70 

Can't orthorectify SPOT7 data Need to be able to orthorectify SPOT7 data (since it is the same as SPOT6). Can't 
orthorectify it using either the SPOT6 RPC or SPOT6 Orbital Pushbroom models.  
Complains that it  "Failed to get metadata for  
//alpha/array4/datalibrary/spot7/prod_spot7_001/vol_spot7_001_a/img_spot7_pms_001_a/di
m_spot7_pms_201502081701287_sen_1233481101.xml." 

1-D1J2AV 

Zonal documentation error: 
Area weighted change metric 
should be checked 

From the following page in help go to: 
file:///C:/Program%20Files/Hexagon/ERDAS%20IMAGINE%202016/help/html/index.htm#zo
nalchange.htm  or type “zonal” in the help documentation.   

Under the topic of Use area weighted change metric, it states the default is unchecked. This 
is incorrect. It should be checked (true/yes/on).    

Also the following text should be deleted as well because it is not exposed from the zonal 
page above:   
 
Scale parameter for the segmentation operator Specify the average number of pixels that 
each output segment will contain; set in FLS Image Segmentation dialog. Keep in mind that 
this is an average and that the variability in the segments sizes will be determined by the 
other parameters, primarily the Size parameter.   The default is 500.   
 
Spectral weight for the segmentation operator Specify how much weight to give the spectral 
component of the segments; set in FLS Image Segmentation dialog.   The default is 1.0.   
 
Texture weight for the segmentation operator Specify how much weight to give the texture 
component of the segments; set in FLS Image Segmentation dialog.   The default is 0.01.   
 
Size weight for the segmentation operator Specify how much weight to give the size 
component of the segments; set in FLS Image Segmentation dialog.   The default is 0.5.   
 
Shape weight for the segmentation operator Specify how much weight to give the shape 
component of the segments; set in FLS Image Segmentation dialog.   The default is 0.5.   
 
Minimum segment size for the segmentation operator Specify the minimum size of the 
segments in pixels; set in FLS Image Segmentation dialog.   The default is 4.0.   
 
Maximum segment size for the segmentation operator Specify the maximum size of the 
segments in pixels; set in FLS Image Segmentation dialog.   The default is 10000.0 

1-G9NQQ6 
MosaicPro: Images are not 
toggled OFF and ON using the 
‘Display raster images’ icon 

Images should be able to be toggled OFF and ON using ‘Display raster images’ when the 
Vis columns in the image rows are selected.  To recreate:  
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1. Run MosaicPro  

2. Edit > Add 2 Images  

3. Select Visibility columns in both image rows  

4. Turn On ‘Display raster images’ icon  

5. Turn Off Display ‘Display raster images’ icon  

6. Turn On ‘Display raster images’ icon again. Images are not rendered in the MosaicPro 
Viewer. You must deselect and reselect the Visible columns to return the rendered images.  
Worked in 13.02 Broken in 14.01, 15.01 

1-HTH1O3 
MosaicPro fails when 
mosaicking ADS80 *.sup files. 

Customer is trying to process a mosaic with ADS80 sup files. The sup files are L2’s which 
have come out of XPro. MosaicPro runs through the buffering process, then fails early into 
the Mosaicking process.  

1-JPFUYG 

HCS Resolution Merge tool 
does not work with WorldView-3 
data in Geo Lat/Lon when using 
Inquire Box 

The HCS Resolution Merge tool does not work if the input is WorldView-3 data in 
Geographic Lat/Lon WGS84 projection (calibrated) and the Inquire Box option is used to set 
the user defined process area. No error messages are reported, the tool just closes after you 
click OK. The session log simply states “modeler.exe exited with status 4”.  

Steps to reproduce the problem:  

1. Display Pan image in a 2D View.  

2. Open an Inquire Box anywhere over the displayed data.  

3. Start the HCS Resolution Merge tool (Raster tab > Resolution group > Pan 
Sharpen > HCS Resolution Merge).  

4. Select Pan image as the High Resolution Input (Pan) File.  

5. Select Multispectral image as the Multispectral Input File.  

6. Enter a name for the output file.  

7. Select the “User Defined” option for the Process Area and click the From Inquire 
Box button.  

8. Leave everything else as the default settings and click OK. 

1-K4S2BB 

MosaicPro: Changing image 
visibility state, images display in 
incorrect order 

When you make an image visible, it gets displayed on top all the other images irrespective of 
its position in the CellArray (if done without seamlines). Zooming in and out or panning 
doesn’t change the arrangement; although the output is in the correct arrangement. 
However, that is not the case when you use the “preview mosaic” option the image last 
displayed after changing the visible status to visible will remain on top. 

 

IMAGINE AUTO DTM 

CR # 
Summary - IMAGINE 
AutoDTM 

Description / How to Reproduce 
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1-DHBBR8 
XPro SGM overlap setting 
can’t be changed  

The overlap setting in XPro SGM can’t be changed from the default 50% to other 
values, so we can’t limit the stereo models to run SGM on.  This is making the 
software run on too many redundant stereo models, which takes much longer.   

 

IMAGINE AUTOSYNC 

CR # 
Summary - IMAGINE 
AutoSync 

Description / How to Reproduce 

1-8LRW2T 

Using the Back / Next button in 
the wizard results in an error 
message 

Steps to reproduce this issue. 

1. From the Toolbox tab, under Autosync Workstation drop down menu 
select "Open Autosync Project" to launch a file chooser. 

2. In the file chooser select an Autosync project file and click OK in the file 
chooser.  The  wizard is launched 

3. Click on the Next or Back buttons. 

4. Notice that an error message shows up.  

 

IMAGINE EXPANSION PACK - ORTHORADAR 

CR # 
Summary - IMAGINE 
Expansion Pack - 
OrthoRadar 

Description / How to Reproduce 

1-1HV8-
41600 

OrthoRadar behaves 
differently depending on DEM 
projection information 

The ortho resampled output one creates using a NAD27 DEM as input in 
OrthoRadar does not spatially match the output one creates using a WGS84 
DEM. 

1-BQ2D9K 

AutoSync’s output image pixel 
size is not the same size as 
input or reference image. 

Using ERDAS IMAGINE 2015 AutoSync a customer sets the pixel size to be the 
same as the input image, but the output image has a pixel size that is different 
than the input image.   

Input image pixel size in degrees: X = 0.0002981625048, Y = 0.0002981625048  

Reference image pixel size in degrees: X = 0.0000904766556, Y = 
0.0000904766556  

Output image pixel size in degrees: X = 0.0002986489037, Y = 0.0002987437183   

1-8ZS6E3 

3D View: Correct the “Import a 
Model Coverage” section of 
the Model Layers workflow. 

There is a mistake in the “Import a Model Coverage” section of the Model Layers 
workflow in the ERDAS IMAGINE help documentation.   

1. Open the IMAGINE Help and from the Contents panel go to 3D 
Visualization > VirtualGIS User Guide > Model Layers Workflow > 
Import a Model Coverage.  

2. Scroll to the bottom of this page until you get to the Import the Model 
Coverage section, which says:  Now you will use the Import Model 
Coverage wizard to import a model to cover the area you digitized in 
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the previous steps.  

o From the 3D View, click File button > Open > Vector Layer.  
A File Selector opens.  

o Select Files of Type > Shapefile.  

o Browse to the directory in which you saved trees.shp, select 
it. Click OK.   

This is not correct.  

1-A1XX0F 

Export NITF 2.1/NSIF 1.0 TRE 
metadata fields do not have a 
valid default value for CEL 

Two NITF/NSIF TRE metadata fields have been identified to use invalid default 
values for the CEL value. The problem is not persisted in every TRE metadata 
field but has been positively identified in TRE ACCPOB and TRE SNSPSB.  To 
observe the problem: 

1. Run Export NSIF 1.0 Imagery  

2. select the IMAGE group to the left  

3. Task -> Add TRE 

4. Parameters: Segment: IMAGE_1, Section: User Data, TRE: ACCPOB  

5. Select ACCPOB in content window  

6. Observe that the CEL value is set to 00000  

Comparison can be made to valid metadata values for TRE: ACCHZB using the 
same steps above where the CEL value is set to 00011 

1-FU8QXH 
KOMPSAT5 is not opening in 
ERDAS IMAGINE 2015 v15.1 

Customer reported that their KOMPSAT5 data doesn’t open in ERDAS IMAGINE 
2015 v15.1.  This appears to be related to data from a specific receiving station. 

1-JSFK4V 
Sentinel-1 kills Image Info and 
CCD immediately. 

Sentinel-1 kills Image Info and CCD immediately upon trying to open the image 
file. 

 

IMAGINE MAP2PDF 

CR # 
Summary - IMAGINE 
Map2PDF 

Description / How to Reproduce 

1-1HY8-
39900 

Export raw image to GeoPDF 
results in error or crash 

Exporting a raw image to GeoPDF results in a crash. 

IMAGINE OBJECTIVE 

CR # 
Summary - IMAGINE 
Objective 

Description / How to Reproduce 
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1-9B05OH 
Objective crashes after adding 
EDA as a VOP and clicking 
Accept to training samples 

Open the attached model in Objective. In Vector Object Operator, select and add 
EDA.  Once EDA is added, the training samples labelled as both turn Red.  
Clicking Accept will cause Objective to crash. 

1-9PXIQK 

IMAGINE Objective crashes 
while using EDA Operator in 
the "Vector Object Processor". 

Customer reported that while using EDA Operator, IMAGINE Objective crashes. 
Customer is using the EDA Operator in IMAGINE Objective in the step "Vector 
Object Processor". Every time he tries to accept the training samples, the program 
crashes. In order to reproduce please do the following:  

1. Open the lfp in Objective  

2. Go to Vector Object Processor  

3. Select: EDA:image  

4. Go to the Training tab  

5. Click on accept.  The program crashes   

1-92UUJ1 

Vector Cleanup Operator 
(VCO) Outlier Clipper 
generates an error: character 
46 is illegal 

Using customer project and data. IMAGINE Objective hangs indefinitely at the VCO 
Outlier Clipper segment of the model.  Further tests shows the Vector Cleanup 
Operator (VCO) Outlier Clipper generates an error: character 46 is illegal in the 
filename   

IMAGINE PHOTOGRAMMETRY 

CR # 
Summary - 
IMAGINE 
Photogrammetry 

Description / How to Reproduce 

1-9A8MDW 

Triangulation cannot 
handle same ray 
images from SPOT5 
Orbital Push broom 
model 

Several issues are observed when triangulating SPOT5 1A PAN images 

1. Some images are from the same orbit, same viewing angle, so the tie points rays do not 
intersect to yield 3D coordinates. 

2. For some images although the Metadata indicates the imaging date/time different, 
triangulation still fail to compute the 3D coordinates because viewing angle is too close. 

3. APM did not collect points where it should be because of small overlaps. 

When you triangulate just with GCPs RMSEs are good. When you triangulate just with ties RMSEs are 
good, but when you introduce ties and GCPs triangulation converges, but GCP RMSEs are too large. 
This doesn’t change when I used Topo center.  

1-852PLS 

Z Scale in 3D view 
has no effect 

To replicate: 

1. Display a LAS file as a Point Cloud in a 2D View.  

2. Start the 3D View option.  

3. Change the 3D View so you can see the height of features.  

4. Now change the Z Scale which, according to the Help, should change the vertical 
exaggeration of the data.   
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However nothing appears to happen - the data looks exactly the same no matter what Z Scale you set. 

1-9ZGEIT 

Pleiades GOP 
model seems have 
some problems to 
handle this data 

We can’t solve the attached block file to get a good geometry. Large Y parallax still remains after 
adjustment but the RPC model for the same data seems good.   

1-A5C7MF 
On-line-help for 
sensor tab broken 

Open a block, click on Interior Orientation icon under Photogrammetry tab and click Help button on 
Sensor tab. You see that the online help is not available for this dialog. 

1-AJIU8N 
Redundant 
messages for 
inactive images  

I start with a block file where some of the images are offline. I made the offline images inactive. When I 
run SGM, I get messages that say the offline images are not available, one for each offline image. 
These messages are needless since the offline images are already made inactive. 

1-B9LB7E 
Unable to generate 
LAZ from XPro SGM 

Online help for XPro SGM mentions that point cloud can be generated in LAZ format but the 
application does not give you an option to select LAZ as an output format. 

1-BDGBL9 

XForm transform 
error message in 
Image Chain 

A specific IMG file does not behave correctly when displayed as Image Chain. To replicate: 

1. Launch ERDAS IMAGINE.  

2. Open the image as Image Chain.  

3. Click ‘Image Chain’ button.  

An error occurs stating: “Spatial Model failed in Raster Cache 3.  Error:  
erdas::raster::XFormMathTransform::Impl::transform failed exfr_TransformN failed 'ICSTransformation' 
XFormTransform failed.” 

1-BGYTHI 

Merging only outputs 
the first point cloud 
in the merge list 

Merging Point Cloud LAS files from Land Survey of Finland generates output only with the first defined 
file (topmost on the list). ERDAS IMAGINE displays only the first file in the list in the output file.   The 
output file’s statistics show that all points are there, but in ERDAS IMAGINE viewer only the first file is 
visible.   

1-BGZDDD 
Terrain Prep Tool 
creates weird RGB 
values  

Terrain Prep Tool creates weird RGB values in the output LAS file, if a LAS file with RGB values is 
used as input and the Filter Point option is set in the pre-process settings.    

1-BLFG41 

"Toggle Automatic 
Cursor Mode" in 
SPM doesn’t work in 
Ribbon  

"Toggle Automatic Cursor Mode" in SPM doesn't work if project is opened from ribbon interface.  SPM 
works normally when opened from Toolbox > LPS > SPM.   

1-BNZ8JF 

File Metadata 
doesn't show 
individual LAS 
metadata and 
always shows 
metadata of latest 
file opened. 

Steps to reproduce. 

1. Launch ERDAS IMAGINE and open two different LAS in separate viewers. 

2. Click in the 1st viewer and launch the metadata.  

3. Click on the File Metadata tab and make a note of the information.   
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4. Click in the 2nd viewer and launch the metadata.  

5. Click on the File Metadata tab and make a note of the information.  

6. In the metadata launched from the 1st viewer browse between tabs i.e., click on any other 
tab and click back on the File Metadata tab.   

Notice that the information shown in the metadata launched from the 1st viewer is that of the metadata 
launched from the second viewer. 

1-BOQQZH 
The preference 
Resampling Method 
for DEM 

Online help says: “The preference Resampling Method for DEM has been moved to the GCP Editor 
category.” This is incorrect. It is moved to the Raster Processing category.   

1-BPMWSX 
SPOT6 & 7 missing 
from supported RPC 
sensors list 

SPOT6 (and 7) RPC is missing from the list of supported RPC sensor files.  

1-BPQOXY 
PATB imported 
incorrectly as digital 
image project 

When you import a frame camera PATB .ori file to block file, the resulting block is a digital camera 
project.  

1-BPRYG7 

Point cloud Offset 
tool doubles the 
offset result when 
saving file. 

Use the Offset tool to offset the elevation of selected points, save the LAS file and check the new 
value. Notice that the offset is doubled.  

1-C0WHFP 

Align Pixels in 
Orthoresampling 
dialog not working 
as requested 

The align pixels button modifies the UL and LR coordinates to be a multiple of the pixel size, but it 
does this based on the coordinates of the center pixel since IMAGINE coordinates are based on pixel 
centers. This should be done based on the corner coordinates.  

1-C5YX89 

Sample posts, Line 
posts and Z plane 
columns of RPC 
Generation tool are 
not editable 

Sample posts, Line posts and Z plane columns of RPC Generation tool are not editable. These entries 
should be editable to let users change the values. 

1-CAS1VP 

Ancillary files are 
preventing Intensity 
display of Point 
Cloud LAS 

Occurs with specific LAS files only. To replicate: 

1. Open the .las into a 2D View as a Point Cloud.  

2. Fit to Frame.  

3. On the Point Cloud tab change Color By to Intensity.  

4. Note that the display (incorrectly) turns entirely black.  

5. On the Table tab turn on the attribute table and note that there are valid values stored for 
intensity.   

6. Now clear the data from the View.  

7. Delete/rename all ancillary files so you are left with only the .las file.  
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8. Redisplay the data into a 2D View.  

This time when you change to Intensity you will get a correct intensity display.  Something in the 
ancillary files is messing up the display of Intensity. 

1-CG965O 
Orthorectification 
creating a white 
PEG2000 output  

Ortho rectification is creating a completely white JPEG2000 output file when the output file projections 
is a non WGS84 / Geographic projection. 

1-DOEV9F 

The Stealth E-
Mouse Setup OLH 
references obsolete 
instructions 

The Stealth E-Mouse Setup references a website location and instructions that are obsolete. 

1-DTK3LR 

Incorrect value 
reported for GCP  
RMSE in 
triangulation report  

Total RMSE for GCPs is expected to be calculated as the square root of (RX^2 + RY^2 + RZ^2) but it 
isn't so. 

1-E5WYAV 

ERDAS IMAGINE 
crashes when 
Vertical reference 
data is reset with a 
DEM without Map 
Info 

Steps to reproduce: 

1. Launch ERDAS IMAGINE and open an LSR block file:  

2. Make sure that all the images are online and then launch CPM  

3. Under tools select “Reset Vertical reference” 

4. Select DEM under Vertical Reference source dialog  

5. Select Find DEM in the dropdown menu and pick a Dem without projection information. 

6. An error message will be shown. Click Ok button. ERDAS IMAGINE crashes 

1-ELJAAS 

Rebuild all pyramids 
does not work if 
there is an existing 
rrd file 

Rebuild all pyramids does not work if there is an existing rrd file. In this scenario, the rrd files should be 
deleted and recreated. 

1-FKGU04 

Point Cloud 
Reproject Operator 
does not run in 
Batch 

Point Cloud Reproject Operator crashes with ‘Run in Batch’. Same model runs without error from 'Run' 
in Spatial Modeler Window.   

1-IAWLAZ 

Point cloud to Raster 
operator taking any 
string even special 
characters as Pixel 
type 

Pixel Type port in Point cloud to Raster operator should have acceptable values.  

1-JS8ALM 

Check points on 
single image are not 
used in triangulation 
summary 

Check points measured on single image are not used in triangulation summary report or review for 
orbital push broom model. This happens when the checkbox "Use Image Observations of Check 
Points in Triangulation" is disabled on Block Triangulation Properties dialog. 
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1-JSFJTY 

GlobalElevationStats 
doesn’t consider 
vertical datum 
change 

There are three places currently using GlobalElevationStats to get z stats: RPC generation, SGM 
preprocess and Block file import/export. However, none of them do vertical datum conversion unless 
the datum is EGM96 or unit is meters.  

1-JSFJYO 
Speckles in ortho 
image  

Specks are seen in Ortho resampling results when the input images have zero values and the cubic 
convolution resampling method is used.  

1-JSFK2W 

The number of point 
in output file  is 
different after 
classification with 
HPC file 

Run point cloud classification with a point cloud in HPC format. Compare the number points in the 
input and output file. The number of points is different. Classification should not remove points. 

 

1-K4TCBB 
XPro SGM crashes if 
disparity difference 
is set to zero 

XPro SGM crashes ERDAS IMAGINE if disparity difference is set to zero. 

1-KFLCWP 

XPro SGM Image 
pair list recalculate 
doesn't update the 
image list  

The Recalculate functionality in SGM Image Pair tab does not update the list unless you go to another 
tab and return to it. 

 

IMAGINE PROFESSIONAL - CLASSIFICATION 

CR # 
Summary – 
IMAGINE 
Professional 

Description / How to Reproduce 

1-9704F2 

Signature Editor crashes 
when adding signatures 
from selected AOIs 

Using specific customer data, the Signature Edit will crash randomly when adding signatures after 
selecting a single AOI. The crash behavior is much more consistent when adding signatures (as the 
first signatures) using ‘Select By Box’ to select AOIs. If a signature exists before ‘Select By Box’ 
adding signature is used, it crashes less often. Sometimes the same AOI signature that that is 
added successfully may crashing the same session if you attempt to add that AOI signature next. 
Adding the first signature when selecting the full extent of AOIs will repeatedly cause the Signature 
Editor to crash.  

1-80L2VN 
Unsupervised 
Classification aborts with 
NoData value #QNAN 

Unsupervised Classification aborts when input image contains NoData values set to #QNAN.  

1-8U79Q1 

Spatial model with 
Attribute filter, Spatial 
query and Preview 
crashes ERDAS 
IMAGINE 

To replicate: 

1. Invoke ERDAS IMAGINE 2013 v13.0.2 

2. Go to: File-> New-> Spatial Model Editor  

3. Open specific gmdx Spatial Model and Click on Preview from Spatial Modeler 

Observe that when the attached model is Previewed ERDAS IMAGINE crashes 
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1-9704F2 

Signature Editor crashes 
when adding signatures 
from selected AOIs 

With some 16 bit data, the Signature Editor will crash randomly when adding grouped signatures 
using ‘Select By Box’ to select AOIs.  The crash may also be seen when adding signatures from 
smaller AOI groups or even single AOI signatures.  To recreate crash:  

1. Open specific 16-bit IMG file in 2D View 

2. Run Raster > Classification > Supervised > Signature Editor  

3. Open AOI  file > AOI Drawing > Select menu > Select By Box Drag the box to select the 
full extent of the displayed AOIs  

4. Select the ‘Create New Signature from AOI’ icon and the software exits. 

 Workaround: Problem seems to be related to a faulty Default bin function written to the data 
(CR#1-K19K1R). Recalculating the statistics using Direct binning function will prevent the crash 
from occurring. 

1-9ATH4K 

Spatial Modeler will not 
process Shapefile with 
hyphen in name. 

A spatial model will not run if it contains an input Shapefile that has a hyphen in its name (ex. 
contours-3.shp). The ERDAS IMAGINE session log will report the messages: “Unspecified function 
failed”, “The expected existing feature metadata was not found.”  If you rename the Shapefile so 
that it does not have a hyphen in the filename, the spatial model will run without any problems. 

1-9D1Q7N 

Discriminant Function 
OLH references 
outdated software option 
labeling 

OLH for Classification > Change Detection > Discriminant Function > Output Options references 
incorrect naming for software options.  Output Options as named in the ERDAS IMAGINE 2014 
software: Additive Change Image:   Subtractive Change Image:  Output Options as named in the 
2014 OLH (and last used in 2011 software): Positive Change Image:   Negative Change Image: 

1-A3R385 

Cannot process/preview 
Shapefile in Spatial 
Modeler when SDI file is 
in the folder 

When an SDI file is in the same folder as a Shapefile, the Spatial Modeler cannot process a 
Shapefile of a different name.  

1-DGB09C 

Specific Shapefiles can't 
be read by the Vector 
Input operator 

Shapefiles in specific Projected Coordinate System can't be read by the Vector Input operator. To 
replicate: 

1. Start Spatial Model Editor.  

2. Add a Vector Input operator.  

3. Double-lick the input port and select one of the affected shapefiles,  

4. Right click on the operator and select Run Just This.   

5. Error: Spatial Model failed in Vector Input.   

6. Error:  erdas::sb_geomedia::VectorSource::OnExecute  failed Warehouse connection is 
not established..    

7. Other Shapefiles associated with other datasets seem to work fine - it's something about 
the PCS that is rejected. 

1-725QZL 
Reconfig python failed--
support 64-bit python 

When executing the “reconfig python” option under the File tab, a "Python cannot be Found 
insearch path or registry" error is displayed. This occurs with Python 64-bit version. 
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1-7DCL7L 

vector layers are not 
overlaying on each other 
after conversion from 
.shp to .gwp 

1) Invoke IMAGINE->Manage data tab->GeoMedia Tools   

2) Select Shapefile to Warehouse option  

3) Use this data:\\alpha\Teamspace\Gnurf\Data\Vectors\zone88_point.shp and 
zone88_polygon.shp 4) After conversion display both shapefile and warehouse file in 2-D view  
"Observe that the vector layers do not overlay on each other"  

Note: This is particular to these shapefiles. Could not observe this behaviour for shapefiles other 
than zone88 

1-FQ1XWX 

Shapefile previewed 
from spatial model 
appears zoomed out 
instead of fit to frame. 

When previewing a Shapefile from a spatial model, the preview displays zoomed out instead of 
fitting to the frame of the View.   Three Shapefiles with different map projections and the spatial 
model “vector_preview_zoom.gmdx” have been copied to \\Alpha\Siebel_Bug_Data\1-FQ1XWX  
Steps to reproduce the problem:  

1. Open the spatial model “vector_preview_zoom.gmdx”.  

2. Select one of the Shapefiles as the Vector Input.  

3. Click the Preview button.  

4. Display the same Shapefile in a different 2D View to see how it should be displayed. 

1-C9H2D4 

DeltaCue - Spectral 
Filtering - On and Off 
icons reversed in 
documentation. 

The help documentation for the Spectral Filtering tools in the DeltaCue Change Display viewer has 
a minor error. The pictures for the “Turn segment selection on” and “Turn segment selection off” 
buttons are reversed in the workflow to turn off a spectral class (steps 2 and 5). The image 
“dqadd.png” is used where “dqsubtract.png” should be and vice versa.  Start the ERDAS IMAGINE 
2015 or 2016 Help and go to Image Interpretation > DeltaCue Contents > Change Display Viewer > 
Spectral Filtering 

1-7X3GQO 

Unsupervised 
Classification should be 
able to process (ignore) 
all NoData values 

Images that have NoData set to value 1.#QNAN cannot be used with Unsupervised Classification. 
Unsupervised Classification aborts when using this data as input.  There is no way for the 
Unsupervised Classification application to ignore this NoData. Unsupervised Classification will work 
when 0 background data is set to NoData Value 0.  Other ERDAS IMAGINE applications cannot 
correctly process NoData set to 1.#QNAN.   These applications include other Modeler operators. 
Median and Stack Median have been cited as not being able to ignore NoData which invalidates 
their output. To recreate:  

1. Run Classification > Unsupervised > NDVI using a Landsat image as input 

2. Select the NDVI index and all other defaults 

3. Run Classification > Unsupervised > Unsupervised Classification using the data 
generated from NDVI as input.   

1-8A50JT 

Problem with Shapefiles 
that have attribute 
names larger than 10 
characters 

The Spatial Modeler has a problem handling attribute column names that are longer than 10 
characters. When trying to access the Shapefile attributes in the Query Builder tool it will add extra 
random characters to the attribute column name. For example, an attribute column name with 11 
characters such as “RibbonWidth” will appear as something like “RibbonWidthF_y___G<” in the 
Query Builder. This “new” attribute column name will be different on different systems and in 
different sessions on the same system.  The resulting query might work on one system, but you 
cannot transfer this model to another system. How to reproduce:  

1. Start a new Spatial Model Editor (File > New > Spatial Model Editor)  

2. Open the spatial model “query_shape.gmdx” (Fie > Open > Open Spatial Model)  
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3. Double-click on the Filename port for the Vector Input operator and select the Shapefile 
“VOO_Centerline1.shp”.  

4. Double-click on the ShapeFileName port for the Shapefile Output operator and enter a 
name for the output Shapefile.  

5. Double-click on the Attribute Query port for the Attribute Filter operator to display the 
Query Builder tool. In the Query Builder click on the Attribute drop-down list and select 
that attribute that begins with “RibbonWidth”.  

You will notice that there are extra characters added to the end of this attribute name. From the 
Operator list select “Less than <”. Enter “3.0” in the Value field and click OK. You can run the model 
if you want, but the problem is the extra characters added to the end of attribute names that are 
longer than ten characters. 

1-8CK2GD 
Opening Processing 
Properties puts icon file 
on recent list 

From Spatial Model Editor, open and close Processing Properties. The file icons/block.ico is put at 
the top of the recent file list. The software shouldn't do this. 

1-8LWNTN 
Count is NOT required 
for Dynamic Table Input 
(List) operator 

OLH for Dynamic Table Input (List) operator indicates that the Count port is required. It is not. 
Count will be derived from the number of list entries if it is omitted. 

1-8N6FFQ 
AOI in Spatial Modeler 
Processing Properties is 
ignored 

AOIs are used in legacy Model Maker, but not in Spatial Modeler. 

1-8UVAZH 

Copy failure of full NDVI 
model. 

When using the pre-packaged NDVI spatial model from clicking "view" under the NDVI 
unsupervised classification in ERDAS IMAGINE you cannot copy the NDVI model. When you 
highlight the desired operators and click copy you receive the error message  "Process has 2 
operators with the display name: 'Min-Max Stretch'". 

1-8WWC7F 

Least Cost Path 
operator misinterprets 
the Cell Size Rule 

The Least Cost Path operator in my model takes in the Start and End point location rasters at 10m 
resolution and the Cost and Elevation rasters at 3m resolution i.e. the operator has (at least) 4 
"parents" which are providing resolution information.  If the Processing Properties  / Grid/Cell Size / 
Cell Size Rule is set to "Minimum of all inputs in model" the least cost path, when previewed, is 
visibly calculated at 3m resolution.  However, if the Processing Properties  / Grid/Cell Size / Cell 
Size Rule is set to "Minimum of parent inputs" the least cost path, when previewed, is visibly 
calculated at 10m resolution (you may need to zoom in / zoom out to get the Preview to refresh).  
As far as I can see, both these rules should result in a 3m output since the Least Cost Path 
operator has parents of both 10 and 3m resolution and so the minimum should be 3m. 

1-92JG0P 

Batch doesn't work 
correctly (determine 
which ports to variablize) 

Batch doesn't correctly determine which ports to variablize. It always adds all of the File Input ports 
even if they are satisfied by incoming links or even if they are hidden. Whereas if you use the run 
button and you will see that it only shows unhidden unsatisfied inputs in its list of things that need 
values. This should be made consistent by requiring the use of Port Inputs. 

1-9981F9 

Using a Spatial Model 
which combines two 
calibrated inputs, the 
output has no map info. 

To reproduce: 

1. Run a specific .gmdx model.  

2. Open Metadata for output file.  

3. It has no map information.   
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4. Now open Processing Properties -> Window tab.  

5. Change from Edges of cell to Centre of cell.  

6. Run again.  

This time the output retains map info.  It should retain map info regardless of that property setting. 

1-9MYEX9 

Spatial Model can't 
handle "#" in path to 
WorldView-3 TIFF data 

To replicate: 

1. Start ERDAS IMAGINE.  

2. File > New > Spatial Model Editor.  

3. Open a specific spatial model which uses as input a TIFF with “#” in the path.  

4. Click Preview - It doesn't work.  The TIFF file can be opened in 2D View.  

5. Similarly, opening it in Image Chain will crash ERDAS IMAGINE. 

1-9X3YN3 

RGB encoding is failing An issue while performing a work flow on  Spatial Model Editor . Work flow steps:   

1. Take two images with .las file extension(sub_1_1.las,sub_2_1.las).  

2. Give them to RGB encoder as point cloud  inputs.  

3. Make RGB encoder  selection port to be hided.  

4. Give image files(sub_1.img,sub_2.img)as inputs to Filename port of RGB Encoder  

5. RGB Encoder outputs are given to a point cloud Merger, Final output(sub1+2_2014.las) 
is taken from point cloud output operator .   

Issue is the output formed is not encoded with R,G,B colours , sometimes   IMAGINE 
Crashing(while performing this work flow). 
model and input data are given in ZIP file 

1-9ZNTZF 
Spatial Modeler Python 
examples throw errors 

Example 3 throws error about disk space, but still runs. Example 4 fails with an error message 
about converting RangeClass to python and produces no output. 

1-ASGP9B 

Can't run classification 
Operators more than 
once - temporary output 
is locked 

1. Open a spaecifc Spatial Model which uses the Unsupervised Classificaiotn operator. 

2. Click Run.  

3. Input one image provided and name the output image. Wait for the Model to complete 
successfully.  

4. Click Run again. Input a second image and name the output image (differently).  

5. You will receive an error stating that the temporary segmentation (and isodata) images 
can't be deleted.  Only by quitting and restarting ERDAS IMAGINE can you run this 
Model a second time.  The two Classification operators need to be modified so that the 
output files are optional so that when run a uniquely named temp file is automatically 
created and cleaned up afterwards.  

1-AUS7GF Cell Y operator returns x Cell Y returns x cell size. This is incorrect for non-square pixels. 
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cell size instead of y 

1-B117PB 
OLH for Aspect operator 
- graphic is wrong 

Bring up OLH for Aspect operator - incorrect graphic is shown. 

1-B2EOVX 
Stack Layer operator 
does not work with only 
one input argument 

Stack Layers operator only works if the function has more than one argument (easy to work around, 
but has to be found out). But it means that legacy GMD models with Stacklayer functions that 
contain only one argument cannot be opened. 

1-B424DX 

Performance warning 
message when creating 
signatures with 
Signature Editor. 

ERDAS IMAGINE gives a performance warning message when creating new signatures with the 
Signature Editor. The warning message says: “Covariance calculation requires stack processing 
but input layer stack isn't suitable.”   If you create the signatures using a full scene of Landsat 8 
data (bands 1-9) it works great, no warning messages. But if you create the same signature from 
the same AOI using a subset image from the same Landsat 8 scene you will get the performance 
warning. This message will occur for every signature added to the Signature Editor. The signatures 
have checks in the “I” column of the Signature Editor’s CellArray.  This problem can also be 
reproduced with “lanier.img” from the IMAGINE example data set. If you remove band 6 from this 
image and create a signature from the new image (bands 1-5&7) you will not receive the warning.  
You can still collect signatures and perform a supervised classification with them and it appears 
that the classification results are not affected. 

1-B5JO1L 

Model with Apply Color 
Table crashes if no color 
table is supplied 

Found while testing the File to File Image Chain models.   Models which have no color table passed 
in to Apply Color Table, and Apply Color Table is the input to a Raster Output, frequently crash in 
Windows 7. In Windows 8, the model gets an error rather than crashing, which is the expected 
behavior. 

1-B76J3Z 
OLH for Color Temp in 
Stretch Panel is 
backwards. 

"Lower values warm up the image by increasing the warmer hues, whereas higher values cool 
down the image by increasing the cooler hues."  Is incorrect. It should be the other way round. 

1-B8GA6Z 
Basic Gaussian missing 
from Stretch Panel Help 

The Basic Gaussian option is not mentioned in Stretch Panel OLH 

1-B9KSHL 

Spatial Modeler Model 
Input gui will not resize 
to include multiple model 
inputs 

The auto-generated Spatial Model input gui will not resize or scroll to select multiple inputs that do 
not fit on the initial dialog display on the monitor. This prevents entering all of the inputs needed to 
run the model when prompted.  

1-B9QT7V 

Preview by RGB 
crashes ERDAS 
IMAGINE 2015 with 
customer’s spatial model 

Customer reported that they detected a preview failure issue in the Spatial Modeler of ERDAS 
IMAGINE 2015. The customer’s spatial model merges four point cloud  LAS  files and encodes the 
merged LAS with RGB from IKONOS data.   Using the preview as output will display the merged 
LAS in the preview display colored by "Elevation" (by default). Switching to” Colored by RGB" will 
cause a crash of ERDAS IMAGINE2015.   

The real output LAS file can be produced without any error. It can be displayed colored by 
"Elevation" or "RGB" without causing crashes. 

1-B9WRV0 

OLH for Create 
Column(s) operator lists 
incorrect input port 
requirements 

OLH Operator Help for Create Column(s) operator lists all 5 input Connections as Required.  The 
Create Column(s) Properties Panel lists only two ports (AttributeName1, AttributeValues1) as 
Required which is correct. 
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1-B9XRH9 

Create Submodel loses 
flow control 

To replicate: 

1. Open <IMAGINE_HOME>/etc/models/normalized_difference.gmdx in Spatial Model 2. 
Editor.  

2. Select everything but Raster Input, Raster Output, and Preview.  

3. Create Submodel from ribbon.  

4. Expand the new Sub-model.  

Flow Control connections from the If are missing. 

1-BB0SIS 
Cell Area isn’t handling 
linear units on Lat/Lon 
images 

The Cell Area operator has not been updated. So if I request Cell Area in Hectares, for a Lat/Lon 
input image, it fails. 

1-BE9Q1M 
Spatial Modeler OLH 
uses mislabelled 
operator icon 

Operator Help for Spatial Modeler 'Set To NoData' operator uses mislabelled icon. Operator icon is 
named 'Set NoData To'. Should be named 'Set To NoData'. 

1-BFUCIO 

Command line operator 
not displaying input port 

To replicate: 

1. Open a new spatial editor  

2. Drag and drop in a Command Line Executable  

3. Select any .exe in the command drop down list  

4. In the ports column, add a new input (Input1)  

5. Enter into arguments panel $Input1  click ok  

The command line operator does not show the input1 port - this used to display in earlier versions  

1-BFZ30P 

Global Histogram does 
not always add a row for 
background (0) 

Problem discovered while trying to build a Model that ran Clump and Sieve and attempted to copy 
attributes (such as colors) from the original image to the output.  But what was discovered was that 
for images that do not contain pixels with value 0 you need to add a Background row to the Sieve 
table, whereas for images that contain 0s you do not.  Sieve works fine in either instance, but trying 
to sync up attributes does not.  It seems like the Global Histogram operator isn't always creating a 
row for 0. 

1-BLDJN7 

Insolation operator 
hangs ERDAS IMAGINE 
after running once. 

To replicate, using a Spatial Model that uses the Insolation operator: 

1. Load Model into a Spatial Model Editor window.  

2. Click Preview.  

3. Results will display in Preview window.  

4. Double click the Date input port and alter the time (put it forward an hour).  

5. Once you click OK on the Date / Time / Zone dialog there will be a slight pause and then 
the Busy icon will come up. And never go away.   

6. If you output to a raster (rather than Preview) you can only run the Model once as well - 
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after running it once and then changing the Time, ERDAS IMAGINE will hang when you 
try to alter the output raster name. 

1-BOSIL9 

Dodge Plus preview 
causes ERDAS 
IMAGINE to crash 

Discovered using a Spatial Model which loads 10 separate images and processes each through the 
Dodge Plus operator before sending the results to a Preview. Once the data has displayed start 
roaming using the middle mouse button from the top left toward bottom right of the data extent. 
After a short period ERDAS IMAGINE will crash. 

1-BPOJ7F 

Spatial Query operator 
Help has diagrams 
which aren't explained 

The diagrams shown on this page  
http://doc.hexagongeospatial.com/ERDAS%20IMAGINE/ERDAS_IMAGINE_Help/#spatial_subset_
port_spatialoperatorport.htm  …might be very helpful if there was some sort of key telling me what 
the color coding means. 

1-BPSU9S 

Condition Editor’s 
“Matches:” drop-down 
menu is missing until 
you move cursor over its 
location. 

In the Condition Editor that is accessed from the Criteria dialog the drop-down menu for Matches 
“ALL rules” or “ANY rules” is missing until you move your mouse pointer over top of where it should 
be located.  How to reproduce the problem:  

1. Double-click on the Criteria operator in a spatial model.  

2. In the Criteria dialog, click the green icon to add a new row, then click in that new row 
under the Condition column to display the Condition Editor dialog.  

3. In the Condition Editor dialog, notice that there is no menu next to Matches (upper-left 
corner).  

4. Move your mouse pointer to the right of Matches and the menu suddenly appears.   

1-BQYP1A 

Modeler batch doesn't 
recognize port without 
file path (e.g., scalar, 
date, string...) 

A Spatial Model has two input ports: one input port for raster, another input port for scalar. The 
model add them together. When you run the model, both scalar and input raster can be specified.  
But if you “Run in Batch” there is no scalar variable at all in the Batch Editor’s command line, so no 
scalar variable can be recognized in the command line, and it is impossible to manually create a 
variable for the scalar. 

1-BT7C3P 

Attribute Lookup with 
incorrect input will crash 
ERDAS IMAGINE. 

1. Launch ERDAS IMAGINE.  

2. File > New > Spatial Model Editor.  

3. Open a specific Spatial Model which includes Attribute Lookup Operator with incorrect 
input.  

4. Run the model.  

5. ERDAS IMAGINE crashes. 

1-BT82V7 

Changing parameter on 
a Running model can 
hang ERDAS IMAGINE 

Discovered while creating a simple Spatial Model which runs Relief on an input DEM and produces 
an output. If you start the Model running, wait until the progress meter is almost (but not) complete 
and then change a parameter (e.g. change Elevation from 45 to 33 and hit Return), 50% of the time 
ERDAS IMAGINE will hang. Sometimes it will "complete" with a red X on the output raster, but 
frequently it hangs instead. 

1-BTG43X 
FLS Segmentation 
crashes with a -
1073741819 error when 
using some Pleiadies 

Open spatial modeler. Add the fls segmentation operator then add the following data 
\\alpha\ARRAY4\DataLibrary\PLEIADES\ORTHO_UTM_BUNDLE\IMG_PHR1A_P_001\img_phr1a
_p_201202250025599_ort_ipu_20120504_1772-002_r1c1.jp2 
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data 

1-BY993P 

HistoEq operator 
outputs only 3 bands for 
4 band input data. 

Discovered when building a Spatial Model which utilizes the HistoEq operator.  The input to the 
HistoEq is 4 bands but output is only 3 bands.  If you change Band Selection to any number of 
bands other than 4, the output has the same number of bands as the input.  This worked correctly 
in previous versions of ERDAS IMAGINE.  

1-BY9RVU 

HistoEq operator 
outputs f64 data, should 
output s32 as 
documented. 

The HistoEq operator outputs f64 data. The Help states that it outputs INTEGER, so the output 
should be s32. HistoEq output is always integral values ranging from 0 to BinCount - 1, so there is 
no need to output float data.  The legacy Modeler HistoEq outputs integer data, as it should. 

1-C9EL0P 

Preview from HistoEq 
operator looks wrong. 

To replicate: 

1. Open a specific Spatial Model using HistoEq.  

2. Click Preview.  

3. Image is not correct. Lacking in red. Previous versions of ERDAS IMAGINE looked 
correct. 

4. Output to file instead of Preview, then view output file, looks correct. 

1-CHSGPN 

Spatial Modeler 
Expression Editor has 
garbage at end of 
operator syntax 

To replicate: 

1. Make sure that your system font is set at 100% and not larger (at least < 125%).  

2. In Spatial Model Editor create an Expression operator.  

3. Double-click the Expression operator to bring up the Expression Editor.  

4. Expand the Favorites category in the tree view and click on Raster Input.  

5. Notice that the syntax label has garbage at the end of each line (it's actually a repeat of 
some valid characters at the end of the line).  

6. Click on different operators and notice that the garbage is there for most (but not all) 
operators. 

1-CJR4FL 

The AOI file chooser 
doesn’t show while 
running a model with 
RasterInput operator 
with AOI port 

Customer reported that if an input AOI port is added in InputRaster operator, when running the 
model it doesn't give a file chose button to locate the AOI file.  If the user manually adds the file 
name, with path, in the box for AOI, the model works. 

1-EDUFKU 

Previewing thematic 
image crashes ERDAS 
IMAGINE when Viewer 
preference set to “No 
Stretch”. 

If you have a thematic image loaded into a Raster Input operator and connect it directly to a 
Preview operator, ERDAS IMAGINE will crash when you attempt to Preview the image if the Viewer 
preference for the Default Stretch is set to "Do not apply the default or saved stretch to data 
values". An error message pops up stating “Tried to set nonexistent property” and then ERDAS 
IMAGINE crashes.  

1-EF5NFT 
Relief operator in 
submodel hangs when 
"Native Type" is passed 

Run a specific model which has the Relief operator embedded in a sub-model and it will hang.  If 
you remove the DEM Units port in the submodel, so that Native Type is set directly on the Relief 
operator, then it works correctly.  Also runs correctly if port is set to Meters instead of Native Type 
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in through input port 

1-EGGHWX 

Errors and omissions 
from IMAGINE 
Segmentation FLS 
operator OLH 

There is inconsistent terminology and omissions in the OLH for the IMAGINE Segmentation FLS 
operator.  - The parameter in the FLS dialog is named ”Pixel:Segment Ratio” and named 
“ScaleFactor” in the Spatial Modeler properties. The Spatial Modeler properties needs to be 
renamed “Pixel:Segment Ratio”.  - The “Pixel:Segment Ratio” description needs to be modified to 
follow the correct description below. "Pixel:Segment Ratio - Specify average number of pixels that 
each output segment will contain. Keep in mind that this is an average and that the variability in the 
segments sizes will be determined by the other parameters, primarily the Size parameter."  - There 
is an omission of “Use Zonal Input Image:” from the GUI OLH  - There is an omission of “ZonalFile” 
from the FLS model properties OLH  See attached docx 

1-EW039F 

Opening specific  .gmd 
in Spatial Model Editor 
crashes ERDAS 
IMAGINE 

Problem discovered when trying to open a legacy .gmd model into Spatial Model Editor. To 
replicate: 

1. From Toolbox tab start the old Model Maker.  

2. Open the model to see that it is a valid model.  

3. Close Model Maker.   

4. Start a Spatial Model Editor.  

5. Click the File Open icon on the Quick Access Toolbar.  

6. Select the .gmd model and click OK.  

7. ERDAS IMAGINE crashes. 

1-EYJDNX 

Rapid Atmospheric 
Correction not 
adequately explained 

Numerous customers have asked for additional detail on what the Rapid Atmospheric Correction 
operator does. The following information should be added to the Help:  Rapid Atmospheric 
correction uses information from companion metadata files (for example, 
<basename>_metadata.xml for RapidEye and *.IMD for DigitalGlobe images) to perform   

1. Absolute calibration: Raw DN counts converted to at-sensor radiance (in units of energy flux);  

2. TOA calibration: sensor-received light radiance is recomputed to the top-of-atmosphere (TOA) 
normalized reflectance (using known season-varying incident sun energy and spectral density 
distribution, as well as sensor sensitivity (spectral response) to the surface-reflected sun energy 
spectrum for each band);  

3. Atmospheric correction: compensation for light scatter and absorption by the atmosphere, 
reducing TOA reflectance to ground-level reflectance. This step involves using image statistics.  
The result is a normalized ground reflectance image scaled by 10000, a common industry practice 
for atmospherically corrected imagery. 

1-FEA04Q 

ERDAS IMAGINE 2015 
v15.1 crashes while 
switching from Elevation 
to RGB when RGB 
Encode  is used with 
Preview 

ERDAS IMAGINE 2015 v15.1 crashes while switching from Elevation to RGB when RGB Encode 
operator is used with the Preview operator.  Customer reported that Spatial Modeler RGB Encode 
Operator for LAS file is working fine. The output delivers color encoded points. However when 
using Preview operator to check the proper results, ERDAS IMAGINE 2015 v15.1 crashes  while 
switching from elevation to RGB display in the preview tab. 

1-FFGU2X 

Global Histogram with 
USEALL option causes 
all Model links to be 
removed (and 

To replicate: 

1. Open a specific spatial model into the Spatial Model Editor  
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subsequently become 
unstable) 

2. Click Run   

3. Specify an Input file  

4. Leave Ignore Option (an input to the Global Histogram operator) blank.  

5. Click OK  - model runs fine.   

6. Now click Run again.  

7. Specify the same Input file  

8. Set Ignore Option to "USEALL" (which the Help implies is a valid option).  

9. Click OK - model fails and also removes all links between operators. (Typing ANY string 
into the Ignore port, not just USEALL, seems to cause this behavior) 

1-FG6FQD 

Volume calculation on 
point cloud in  “Point 
Cloud Volume”  operator 
and in GUI  is  not 
working. 

Volume calculation on point cloud in “Point Cloud Volume” operator and in GUI is not working.  
Customer reported that volume calculation on point cloud not working at all with their data.  The 
customer’s las file is in WGS84 / Geographic projection. Their aoi consists of four regions. However 
after Volume calculation, when looked at the detail of output shapefile it looks as though the tilling 
has completely ruined the output. Only the top and bottom areas calculate then the middle is 
ignored. 

1-FYLVZZ 

Renaming a port in the 
Expression Editor does 
not change the 
reference in the 
Expression: window 

The rename function in the Expression Editor does not change the reference in the ‘Expression:’ 
window. The rename function shows ports under both the ‘new’ and ‘original’ name in the ‘Port:’ 
window. The port using the ‘original’ name is shown as unconnected in the Expression operator.   
The new port name reference is not replaced in the ‘Expression:’ window by the Rename function 
as implied in the Help, which states “Rename  - This button is disabled until a port is selected. 
When a port is selected, click to display a text entry dialog to enter the new name. NOTE: Port 
names must be unique. If a non-unique name is entered, a warning message will indicate this and 
the rename will not happen. When a unique name is entered, the port is renamed and the all the 
references in the expression will be replaced by the new name.”  This behavior is not seen in every 
model.  Sometimes the references are changed in the ‘Ports:’ window, but not in the ‘Expression:’ 
window.  

1-G036YK 

ERDAS IMAGINE 
crashes when increasing 
size of Custom Table 
Input before changing 
Data Type to String. 

ERDAS IMAGINE will crash if you try to create a table with empty rows with the data type set to 
String. Steps to replicate the problem:  

1. Start the Spatial Model Editor.  

2. Drag the Custom Table Input operator into the  editor 

3. Double-click the operator to open its configuration dialog.  

4. The Table Source dialog opens.  

5. Leave the Data Type set to Float.  

6. Increase the size from 0 to 1.  

7. Change the Data Type to String.  

8. A warning message will pop up stating “Cannot convert existing data to/from String type.” 

9. Click OK.  

10. Do not enter anything in the new row and click OK in the Table Source dialog.  

ERDAS IMAGINE crashes and the session log reports “external process exited with status -
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1073741819.”  

1-GHFAOU 

New lines are not 
preserved in Expression 
Editor. 

If you press the Enter key to create a new line in the Expression Editor, the new line(s) will not be 
preserved if you save the model and reopen it. All of the separate lines are combined into one long 
run-on expression, which makes it difficult to read.  For example, if you enter the following in the 
Expression Editor…  

EITHER 1 IF ( $Input1 < 5 ) OR $Input1 OTHERWISE   

# comment 1 EITHER 2 IF ( $Input1 > 5 ) OR $Input1 OTHERWISE   

…after you save and reopen the spatial model and then double-click on the Expression operator, 
the expression becomes this:  

EITHER 1 IF ( $Input1 < 5 ) OR $Input1 OTHERWISE # comment 1EITHER 2 IF ( $Input1 > 5 ) OR 
$Input1 OTHERWISE 

1-JJK8DF 

Unneeded model 
branches are run with 
'Run Just This' in 
models using 
Submodels 

A preceeding Submodel causes all the model branches to be run when 'Run Just This' is done for a 
resulting raster placed after the Submodel. 

1-JJK8K5 

Spatial Modeler hangs 
using 'Run Just This' 
from Rasters and other 
operators placed behind 
the Submodel 

Spatial Modeler will hang if 'Run Just This' is used from a raster and other operators that are placed 
behind the Submodel. If the Raster operator is the last operator behind the Submodel, the model 
does not hang.  When using 'Run Just This' from the Submodel that is placed in front of the Raster 
operator or other operators behind, the model will not hang. 

1-JJOOG9 
Provide a way to Undo 
Submodel creation 

Once a Submodel group is created, the Submodel cannot easily be returned back to ungrouped 
operators. This limits the editing functionality of the model. 

1-JMEBQT 

A letter ‘r’ is not shown 
in the 
ApproximationMaxorder 
dialog corresponding to 
Warp operator 

1. Launch ERDAS IMAGINE  and start Spatial Model Editor   

2. Drag the Warp operator to the Spatial Model Editor  

3. Double click on port corresponding to default value 3  

4. ApproximationMaxOrder dialog opens  

Observe that “ApproximationMaxOrde” shown instead of ApproximationMaxOrder i.e. letter ‘r’ is 
missing/not shown beside edit box 

1-JPVIKR 
Dynamic Matrix Input 
(List) doesn’t generate 

Customer Reported that the Dynamic Matrix Input (List) doesn’t generate any output when 
connected to the ‘Matrix File Output Operator‘ 

1-KJOD2X 

Square Root operator 
not producing 
appropriate output for 
negative values. 

To replicate: 

1. Launch ERDAS IMAGINE,  

2. Launch Spatial Model Editor.  

3. Drag the scalar input and square root operators to the editor and connect them.  

4. Give scalar input as -3 and run the model and observe output is -1.#IND which is not a 



 

Issues Resolved 

May 26, 2016 98 

proper output (should be Not a Number – NaN) 

IMAGINE SAR INTERFEROMETRY 

CR # 
Summary – IMAGINE 
SAR Interferometry 

Description / How to Reproduce 

1-1HZK-22100 
Filtered Interferogram NOT 
correct 

Frequently the Filtered Interferogram shows effects other than filtering; The final 
result still seems OK, but the intermediate image is incorrect calling the results into 
question  

1-9SQMHP 

DEM from InSAR created 
with COSMO SkyMed data 
is offset 300 meters from 
correct location. 

A pair of COSMO SCS_B Level 1A Spotlight images are used with InSAR to create 
a DEM. The height values of the output DEM are good, but it is not in the correct 
location. There is a shift in the X direction ranging from 300 m to 1000 m. Using 
OrthoRadar to orthorectify one of the images exhibits a similar shift. 

1-BFYQDU 

Spectral Shift filter for 
Radar Interferometry tools 
does not work with COSMO 
SkyMed data. 

The Spectral Shift step in the Radar Interferometry tools (InSAR, CCD) does not 
work when using COSMO SkyMed data. This step works fine with TerraSAR-X 
data.  If you turn on the Range option the software states that the Spectral Shift 
Filtering is available, but if you try to execute the Spectral Shift step it doesn’t really 
do anything. It “reads” the images in a few seconds, but that is about it. No 
checkmark ever appears beside the Spectral Shift step. Also, if you try to calculate 
the theoretical quality gain you will get a message saying “Theoretical quality gain 
of Spectral Shift Filtering cannot be computed (see Session Log for details)”, but 
there are no details in the session log. 

1-JSFK5N 
InSAR DEM GCP 
evaluation probably not 
working 

Path differences for all GCPs are the same. This indicates the tool is not working. 

IMAGINE STEREO ANALYST 

CR # 
Summary - IMAGINE 
Stereo Analyst 

Description / How to Reproduce 

1-DB31J5, 
1-C9KSN9 

Stereo Analyst fails to 
generate proper pyramid 
layers  

Pyramid layers generated in Stereo Analyst can’t be read by Stereo Analyst. If 
pyramids are generated in IMAGINE using Image command tool or some other 
processes, Stereo Analyst can read it.     

1-BR2TMF 
JP2 images can’t be opened  JP2 images can’t be opened in Stereo Analyst. The same images can be opened 

in IMAGINE viewer and Terrain Editor. 

IMAGINE TERRAIN EDITOR 

CR # 
Summary - IMAGINE 
Terrain Editor 

Description / How to Reproduce 

1-AMXV73 OLH for Control Point 
Display Settings dialog is 

Steps to reproduce: 
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broken. 1. From Terrain Editor, launch Ground Control Points panel.   

2. Within this panel click on the Settings button to launch Control Point 
Display Settings dialog. 

3. Click on the Help button.  Notice that no OLH is launched. 

1-AMXV7N 
OLH for Create New 
Window dialog is broken. 

Launch TE and from the Window menu select New Window. - Click on the Help 
button of the Create New Window dialog.  Notice that the OLH doesn't launch. 

1-BRY41V 
Geomorphic and Area 
editing tools give error 

Geomorphic and area editing tools give errors and TE crashes. Note that if you 
Go to "Terrain Files and Display" and select contours or triangles and repeat the 
geomorphic editing again the error message won't happen. 

 

ERDAS ER MAPPER 
CR # Summary – ER Mapper Description / How to Reproduce 

1-97KRO8 
ER Mapper does not calculate 
RMS Values in GeoCoding 
Wizard 

Attempt to rectify image using GCPs - polymodal model in ER Mapper 2014.01 RMS Value is 
not calculated. However customer can see RMS values in version 10.0. 

1-9QYU1V 
ERMapper crashes 
mosaicking 306 img files  

ERMapper crashes mosaicking 306 img files.  

1-A0O1HT 

Image Compression wizard 
crashes for input ECW v3 
Mosaicked files, ECW 
compress MFC stops working 

To replicate: 

1. Launch ER Mapper 2015. 

2. Select Image Display and Mosaic wizard.  

3. Specify the input data set   

4. Choose the options,   a. Display image in 2D   b. Mosaic all file of this type.   c. 
Contrast stretch image(s) upon loading  

5. Click Next and then once Mosaicking is done click Finish button.  

6. Now save the Mosaicked image as compressed image (ECW v2,ECW v3 or JPEG 
2000)(Use all default options in Compression Wizard).   a. File->Save as 
Compressed Image   

The process crashes after some time.   

1-K9Q1JQ 

Opening 3D Alg using 'Open 
Dataset as Algorithm' option 
crashes ERDAS IMAGINE 

To replicate: 

1. File > Open > Dataset as Algorithm  

2. Open our example data: C:\Program Files\Hexagon\ERDAS IMAGINE 
2016\examples\ermapper\applications\mineral_exploration\3D_clay_and_iron_oxid
e_over_magnetics.alg   
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3. ERDAS IMAGINE crashes 
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ABOUT US 
Hexagon Geospatial helps you make sense of the dynamically changing world. We enable you to envision, 
experience and communicate geographic information. Our technology provides you the form to design, develop 
and deliver solutions that solve complex, real-world challenges. Ultimately, this is realized through our creative 
software products and platforms. 

CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including local, state and 
national mapping agencies, transportation departments, defense organizations, engineering and utility companies, 
and businesses serving agriculture and natural resource needs. Our portfolio enables these organizations to 
holistically understand change and make clear, reliable decisions. 

TECHNOLOGY. Our priority is to deliver products, platforms and solutions that make our customers successful. 
Hexagon Geospatial is focused on developing technology that displays and interprets information in a 
personalized, meaningful way. We enable you to transform location-based content into dynamic and useable 
business information that creatively conveys the answers you need.  

PARTNERS. As an organization, we are partner-focused, working alongside our channel to ensure we succeed 
together. We provide the right platforms, products, and support to our business partners so that they may 
successfully deliver sophisticated solutions for their customers. We recognize that we greatly extend our reach and 
influence by cultivating channel partner relationships both inside and outside of Hexagon.  

TEAM. As an employer, we recognize that the success of our business is the result of our highly motivated and 
collaborative staff. At Hexagon Geospatial, we celebrate a diverse set of people and talents, and we respect 
people for who they are and the wealth of knowledge they bring to the table. We retain talent by fostering individual 
development and ensuring frequent opportunities to learn and grow. 

HEXAGON. Hexagon’s solutions integrate sensors, software, domain knowledge and customer workflows into 
intelligent information ecosystems that deliver actionable information. They are used in a broad range of vital 
industries.  

Hexagon (Nasdaq Stockholm: HEXA B) has more than 16,000 employees in 46 countries and net sales of 
approximately 3.4bn USD. Learn more at hexagon.com and follow us @HexagonAB. 
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Copyright  

© 2016 Hexagon AB and/or its subsidies and affiliates. All rights reserved. Hexagon has registered trademarks in many countries throughout 
the world. Visit the Trademarks Page for information about the countries in which the trademarks are registered. See Product Page and 
Acknowledgments for more information. 

Product Documentation Terms of Use 

PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S DOCUMENTATION ("DOCUMENT"). USE OF 
THIS DOCUMENT INDICATES ACCEPTANCE OF THIS AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO THE 
TERMS HEREOF ("TERMS"), DO NOT USE THIS DOCUMENT. 

Use Of This Document 

All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, trademark, and other laws. Subject 
to the terms of this Agreement, Hexagon Geospatial (a Division of Intergraph Corporation) and Intergraph’s subsidiaries ("Intergraph") hereby 
authorize you to reproduce this Document solely for your personal, non-commercial use. In consideration of this authorization, you agree to 
retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any way or reproduce or publicly 
display, perform, or distribute or otherwise use them for any public or commercial purpose, except as specifically authorized in a separate 
agreement with Hexagon Geospatial.  

The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution of rights of a third party. Except as 
expressly provided above, nothing contained herein shall be construed as conferring by implication, estoppel or otherwise any license or right 
under any copyright, patent or trademark of Hexagon Geospatial or Intergraph or any third party. 

If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon termination, you will immediately 
destroy any downloaded or printed Materials in your possession or control. 

Disclaimers 

ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, OR NON-INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be error-free, that defects 
will be corrected, or that any Hexagon Geospatial Website or the services that make Materials available are free of viruses or other harmful 
components. 

Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial may make changes to this 
Document at any time without notice. 

Limitation Of Liability 

IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER 
IN AN ACTION IN CONTRACT OR TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT. 

Indemnification 

You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, and agents from and against any 
and all claims, liabilities, damages, losses or expense, including reasonable attorneys’ fees and costs, arising out of or in any way connected 
with your access to or use of this Document. 

Use Of Software 

Use of software described in this Document is subject to the terms of the end user license agreement that accompanies the software, if any. 
You may not download or install any software that is accompanied by or includes an end user license agreement unless you have read and 
accepted the terms of such license agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors. 

Links To Third Party Websites 

This Document may provide links to third party websites for your convenience and information. Third party websites will be governed by their 
own terms and conditions. Hexagon Geospatial does not endorse companies or products to which it links. 

Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no control. Hexagon Geospatial shall 
not have any liability resulting from your use of the third party website. Any link you make to or from the third party website will be at your own 

http://www.hexagongeospatial.com/legal/trademarks
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risk and any information you share with the third party website will be subject to the terms of the third party website, including those relating to 
confidentiality, data privacy, and security. 

Trademarks 

The trademarks, logos and service marks ("Marks") displayed in this Document are the property of Hexagon Geospatial, Intergraph or other 
third parties. Users are not permitted to use Marks without the prior written consent of Hexagon Geospatial, Intergraph or the third party that 
owns the Mark. "Intergraph" is a registered trademark of Intergraph Corporation in the United States and in other countries. Other brands and 
product names are trademarks of their respective owners. 

Find additional trademark information. 

Procedure For Making Claims Of Copyright Infringement 

Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following address: Intergraph Corporation, 
Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 35824. 

US Government Restricted Right 

Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. Government is subject to 
restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or successor provisions thereto. Use of Materials by the 
Government constitutes acknowledgment of Hexagon Geospatial or Intergraph’s proprietary rights therein. 

International Use 

You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial makes no representation that 
Materials are appropriate or available for use in every country, and access to them from territories where their content is illegal is prohibited. 

Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain references or cross references to 
Hexagon Geospatial products, programs and services that are not announced in your country. These references do not imply that Hexagon 
Geospatial intends to announce such products, programs or services in your country. 

The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree to comply strictly with all such 
laws and regulations. In addition, you represent and warrant that you are not a national of, or otherwise located within, a country subject to U.S. 
economic sanctions (including without limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited from 
receiving or accessing the Materials under U.S. export control and economic sanctions laws and regulations. Hexagon Geospatial makes no 
representation that the Materials are appropriate or available for use in every country, and access to them from territories where their content is 
illegal is prohibited. All rights to use the Materials are granted on condition that such rights are forfeited if you fail to comply with the terms of 
this agreement. 

Revisions 

Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly reviewing these Terms. Your 
continued use of this Document after the effective date of such changes constitutes your acceptance of and agreement to such changes. 

Applicable Law 

This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of the State of Alabama will govern 
these Terms, without giving effect to any principles of conflicts of law. You hereby irrevocably and unconditionally consent to submit to the 
exclusive jurisdiction of the United States District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for 
Madison County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to commence any litigation relating 
thereto except in such courts), waive any objection to the laying of venue of any such litigation in such Courts and agree not to plead or claim in 
any such Courts that such litigation brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions 
or limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the maximum extent allowed by applicable 
law. 

Questions 

Contact us with any questions regarding these Terms. 
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